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1 Document Purpose 
This document for Automation Anywhere Enterprise (AAE) 10 SP2 (Service Pack) with product version 10.5.0 mentions the 

prerequisites and provides a step by step guide to installing the Enterprise Control Room and Client. 

 

Note: If you are upgrading an existing version of Automation Anywhere Enterprise and if already have a hands-ON 

experience in installing AAE Client and Control Room, please follow the upgrade steps mentioned in Upgrade Sequence. 
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2 AAE Control Room - Prerequisites 
This section helps you determine whether your system has the proper hardware and software to install the Control Room. 

Before installing the Enterprise Control Room, verify that your environment* supports the requirements mentioned in the 

sections that follow. 

* Applicable to physical as well as virtual deployment environment. 

2.1 Product Requirements – Express and Custom Standalone Installation 

Applicable for Express and Custom-Standalone mode of installation. 

2.1.1 Software Requirements 

Operating Systems 
Microsoft Windows 7 SP1 (Minimum) 

Microsoft Windows Server 2012 R2 (Recommended) 

Web Server/IIS  Internet Information Services 7.5 onward 

.NET Framework 

For Windows 8.1 and Window Server 2012 R2: 

Microsoft .NET 4.6.1 (Minimum) 

For other Supported Operating Systems: 

Microsoft .NET 4.6 (Minimum) 

(Note: The .NET Framework 4.7 update is also supported) 

Data Management System For Express:  

Microsoft SQL Server 2014 Express Service Pack 1 (SP1) 

For Custom Standalone:  

Microsoft SQL Server 2012 Express/Standard/Enterprise or higher 

2.1.2 Hardware Requirements 

Processor 
x64 Server Based CPU with 8 Cores 

Hyper-threading recommended (if applicable) 

RAM 8 GB (Recommended) 

Disk Space 100 GB (Depends upon Repository size) 
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2.1.3 Region Format and Settings (Language Locale) 

You can verify and update the Region Format and Settings i.e. the Language Locale from Control Panel → Region. 

• To update your Region Format, select the Format tab. 

a. It is recommended that you select English (United States) as your Region Format 

  

• To update your Language Locale, select Administrative → Change system locale…  
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a. It is recommended that you select English (United States) as your Region Settings 

  

2.2 Product Requirements – Distributed Installation 

Applicable for Custom-Distributed mode of installation 

2.2.1 Application Server - Software Requirements 

Operating System 
Microsoft Windows 7 SP1 (Minimum) 

Microsoft Windows Server 2012 R2 (Recommended) 

Web Server/IIS  Internet Information Services 7.5 onward 

.NET Framework 

For Windows 8.1 and Window Server 2012 R2: 

Microsoft .NET 4.6.1 (Minimum) 

For other Supported Operating Systems: 

Microsoft .NET 4.6 (Minimum) 

(Note: The .NET Framework 4.7 update is also supported) 

Data Management System Microsoft SQL Server 2012 Express/Standard/Enterprise or higher 

Java Framework JRE 1.6 onward 

2.2.2 Application Server - Hardware Requirements 

Processor 
x64 Server Based CPU with Minimum 4 Cores 

Hyper-threading recommended (if applicable) 

RAM 8 GB 

Disk Space 20 GB (Depends upon repository size) 
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2.2.3 Shared Data Server - Software Requirements 

Operating System Microsoft Windows Server 2012 R2 

2.2.4 Shared Data Server - Hardware Requirements 

Processor 
x64 Server Based CPU with Minimum 8 Cores 

Hyper-threading recommended (if applicable) 

RAM 8 GB 

Disk Space 100 GB (Depends upon repository size) 

Shared Drive - 

 

2.2.5 Load Balancer Configuration for High Availability 

You can select a Load Balancer as per your requirements. You can configure your Load Balancer either as a software or as 

a hardware. Ensure these configurations are enabled in the Load Balancer. 

Configuration Description 

Cookie-based sticky 

session 
Enable cookie-based sticky session in the configuration of Load Balancer. 

Expiration time of the 

cookie 
Set the expiration time of the cookie same as the user session expiration time. 

 

2.3 Supported Operating Systems 

Operating System Edition 

Microsoft Windows 10 Pro, Enterprise 

Microsoft Windows Server 2012 R2 Standard, Datacenter 

Microsoft Windows Server 2012 Standard, Datacenter 

Microsoft Windows 8.1 Pro, Enterprise 

Microsoft Windows 8 Pro, Enterprise 

Microsoft Windows Server 2008 R2 Standard 

Microsoft Windows 7 SP1 Professional, Enterprise 

2.4 Internet Information Services 

Internet Information Services (IIS) Windows Version 
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IIS 10.0  Windows 10 

IIS 8.5 Windows 8.1 & Windows Server 2012 R2 

IIS 8.0  Windows 8 & Windows Server 2012 

IIS 7.5 Windows 7 SP1 & Windows Server 2008 R2 

Application Initialization Module for IIS 7.5 Windows 7 SP1 
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2.5 Version Control Integration (If enabled) 

Subversion*: 
* Subversion is provided by the Apache Subversion software project. 

Subversion SVN Server 

Subversion 1.8.13 and 1.8.14 Visual SVN Server 3.3.x  

Subversion 1.7.2 Visual SVN Server 2.5.2 

NOTE: You can configure your own instance of Subversion; although we recommend Visual SVN Server as the SVN Server 

for Subversion. 

SVN repository with an Admin account 

2.6 Enabling IIS Features* 

* These can be enabled from Turn Windows feature on or off option 

This section describes the steps required to enable the following features in Windows Server 2012 R2: 

 ASP .NET 4.5 or higher 

 .NET Extensibility 4.5 

 ISAPI Filter 
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 Static Content 

 
 

 Windows Authentication (for Active Directory Users) 

 
 IIS Management Service (applicable only for Windows 7 SP1) 

NOTE: Ensure that 'WebDAV Publishing' is not installed. 
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2.7 Browser Support 

Browser Version 

Internet Explorer 10 and 11 

Chrome 49 and above 

Firefox 45, 46, and 47 

2.8 SQL Server Configurations 

Ensure that the Microsoft SQL Server configurations are in place before setting up the database for Control Room. 

2.8.1 Prerequisites for installing SQL Server 

 SQL Server Management Studio must be installed. Refer the Software Requirements section to know supported 

versions. 

 You should have access to “AAE_10.3.0_MSSQL_Express_2014SP1.exe” 

 You should have administrator rights to run the setup. 

2.8.2 Configuring SQL Server Settings 

SQL Server settings can be configured in the SQL Server Configuration Manager.  

 Enable protocol for Named Pipes and TCP/IP in SQL Server Network Configuration → Protocols for MSSQLSERVER as 

shown: 

 
 

 If you have opted for custom installation, the next step involves setting the TCP/IP port. Context click (right-click) or 

double-click TCP/IP protocol, input the port number for IPAll in the IP Addresses tab of IP Properties as shown: 
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TIP: Restart the MSSQLSERVICE for the updates to take effect. 

 

2.9 Pre-Upgrade Checklist (For both Standalone and Distributed deployment - High-Availability Control 

Room) 

• Take backup of Control Room database 

• Take backup of Control Room repository  

• To compare & validate data like, Registered clients, Active users, No. of folders and files in Control Room 

repository etc… post-installation, take screenshot of Control Room Dashboard  

• As this is a full setup upgrade, complete downtime for Control Room and Client is recommended. 

• Make sure you have a Non-admin user of Control Room with license management permission and a Control 

Room Admin user 

• Ensure the user who runs the setup has required access privileges to the folder that is chosen as repository 

path. 

Please note during upgrade, 

• All the AAE Clients are disconnected. Also, none of the local schedules on the AAE Clients or Control Room are 

executed until upgrade process is completed. 

• User must re-login to all the AAE Clients after upgrade process is completed. 

2.10 Upgrading Control Room Server(s) 

Upgrading Control Room with full setup is equivalent to installing a new Control Room server 

Follow the steps mentioned below to upgrade the Control Room Server in Standalone mode  

1. Uninstall current Control Room using steps as per section 3.8. 

2. Check if all the files and folders are removed from previous installation of Control Room server in Installation 

directory. 

3. Check and ensure that there is no Control Room entry for previous version in Control Panel (Control Panel\All 

Control Panel Items\Programs and Features). 
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4. Check if the Database still exists in the Database server and Repository files/ folders existing in same repository 

location. 

5. Install the Control Room 10 SP2 (10.5.0) on the same Control Room server using existing Database and 

Repository. This installs both data & service layer and application server at once as both exist on the same 

machine, refer section 3.5 

6. After clicking on Finish screen, go to installation path (Example: C:\Program Files (x86)\Automation Anywhere 

Enterprise 10.5\Control Room) and verify if version in “ProductReleaseInfo.xml” file – It should be 10.5.0.0 – 

XXXXXXX. 

7. Go to Windows services and verify if “Automation Anywhere Web socket service” is running 

8. Login to Control Room using Non-admin user with license management permission with Control Room server URL 

and install license provided by AA sales and support team, if asked. 

9. Go to installation path (eg: C:\Program Files (x86)\Automation Anywhere Enterprise 10.5\Control Room\ 

Web\webcrsvc\bin) and verify date and time stamp for “AAECR.license” file; it should be latest. 

10. Login using same Non-admin user having license management rights and go to license management tab to verify 

available license count. 

11. If the license count is verified and as expected then login using Control Room Admin user, go to Help → About 

page and verify if the latest Control Room version is- 10.5.0 (Build XXXXXXX). 

12. Login with Control Room Admin user, go to Control Room settings page and verify all the settings like, Repository 

path, Outgoing mail server, VCS, Credential vault etc. 

13. Go to IIS manager and follow steps as per section 3.6.4 - Setting up Https Site Binding if you want to change 

binding details. 

2.10.1 Upgrade Control Room Server in Distributed Mode (High-Availability Control Room) 

When you upgrade your Control Room from previous v10.x to new v10.5.0 (SP2), you need to first uninstall existing setup 

from all servers and then need to upgrade the shared data & services as well as the Application Server(s) one at a time. 

Follow the steps mentioned below to upgrade the Control Room Server: 

1. Uninstall current Control Room using steps as per section 3.8, from the shared data & services as well as the 

Application Server(s) machines. 

2. Ensure on all the servers if all the files and folders have been removed for previous installation of Control Room 

server from Installation directory. 

3. Ensure on all the servers that there is no Control Room entry for previous version in Control Panel (Location: 

Control Panel\All Control Panel Items\Programs and Features). 

4. Check if the Database still exists in the Database server and Repository files/ folders existing in same repository 

location. 

5. Install the Control Room 10.5.0 (SP2) to upgrade your shared data and services layer (Web socket). Refer section 

3.6.1. 

NOTE: Upgrade passive web socket node and active node both one by one. 

6. After clicking on Finish screen, go to Windows services and verify if “Automation Anywhere Web socket service” is 

running on Active node. 

7. Login to application server machine 

8. Install Control Room 10.5.0 (SP2) to upgrade first Application Server. Refer section 3.6.3. 

9. After clicking on Finish screen, go to installation path (eg: C:\Program Files (x86)\Automation Anywhere 

Enterprise 10.5\Control Room) & verify version in “ProductReleaseInfo.xml” file – It should be 10.5.0.0 – XXXXXXX 

10. Go to control panel (Control Panel\All Control Panel Items\Programs and Features) and verify Automation 

Anywhere Enterprise Control Room 10.5 version – It should be 10.5.0. 

11. Go to Windows services and verify “Automation Anywhere cache manager service” is running. 
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12. Login to Control Room using Non-admin user having license management rights, with application server URL and 

install license provided by AA Sales and Support team. 

13. Verify the same license file “AAECR.license” and its date and time stamp in Repository folder, it should also be 

latest 

14. Go to installation path (Example: C:\Program Files (x86)\Automation Anywhere Enterprise 10.5\Control Room\ 

Web\webcrsvc\bin) and Verify date and time stamp for “AAECR.license” file, it should be latest. 

15. Login with application server URL using same Non-admin user having license management rights and go to license 

management tab to verify available license count. 

16. . If the license count is verified and as expected then login with application server URL using CR Admin user, go to 

Help → About page and verify Control Room version it should be - 10.5.0 (Build XXXXXXX). 

17. Go to IIS manager and follow steps as per section 3.6.4 - Setting up Https Site Binding if you want to change 

binding details. 

18. With Control Room Admin user login, go to Control Room setting page and verify all the settings like, Repository 

path, Web socket host and port, Control Room URL, Outgoing mail server, VCS, Credential vault etc. 

19. Repeat steps from 7 to 11 along with steps 14 to 17 for all Application Servers. 

20. Once all the Application Servers are upgraded with latest Control Room version i.e. 10.5.0 (SP2), follow the steps 

as per section 3.6.3 on all Application Servers to have Application cache manager service sync up between all 

Application Servers. 

21. Login using Load Balancer (LB) URL with Control Room Admin user and verify the following: 

a. Go to license management and verify license count. 

b. Go to Control Room settings page and verify settings as per step# 17 in section 2.10.1 
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3 AAE Control Room - Installation 

3.1 Installing the Control Room 

You can install the AAE Control Room using the AAE Control Room Setup wizard. The setup will allow you to select two 

different methods of setting up and configuring the Control Room – Express and Custom. The setup wizard installs any 

prerequisite that might be missing.  

Via the setup, you will also be able to configure Web Socket & Database with respective Ports, Application components, 

Shared Data components, Services components, Website, Repository, User type, Application path, and Application 

shortcuts. 

Before running the Control Room setup, ensure all prerequisites to configure the application are met. Refer the 

Prerequisites section for details.  

Also, it is recommended that you run the setup in Admin mode as while installing the application some system updates 

are made in services and registry. 

Control Room can be installed and configured using any of the two methods: 

• Express - Use the Express option to quickly install the Control Room with default settings  

NOTE: We do not recommend using Express mode of Installation in the production environment. 

• Custom - Use the Custom option if you want to install the Control Room with manual settings. This installation 

type is recommended for production use 

3.2 Installing the .NET Framework 

The Control Room setup wizard automatically installs the required prerequisites if found missing. 

NOTE: If you already have installed a previous version of Control Room, ensure you perform a complete uninstall. This can 

be done from the Control Panel → Programs and Features. 

 If .Net 4.6 component is missing, a pending component screen to install Microsoft .NET Framework 4.6 appears as it 

forms part of the Control Room prerequisites. Click Install 
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 You will be able to see Microsoft .NET Framework 4.6 installation process.  

 
 You need to restart your system to complete the Installation process. The installation process will automatically 

resume, after you restart your system. 

 

3.3 Express Installation 

Express mode of installation allows you to set up the Control Room quickly with minimal steps. By using default values, it 

automatically configures the required parameters for different components. 

This method of installation is recommended for a non-production environment only. 

 Important: Save your work and close all the open applications before you begin the installation. 

• If not installed, run the installer for AAE_10.3.0_MSSQL_Express_2014SP1.exe in Admin mode. This will install 

the Database Management System – Microsoft SQL Server Express 2014 (SP1) 

NOTE: The self-extracting exe allows to install only the SQL Engine for SQL Server Express 2014 SP1. It does 

not install the SQL Server Management Studio. 

• It will configure an instance AACRSQLEXPRESS, which will be used for the Control Room database. 

NOTE: This instance will be used to create the default Control Room database “CRDB”, which will be 

configured only after you select the Express Mode of Control Room installation. 

• Now launch the Setup for Control Room in Admin mode.  
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The following steps describe the installation of Control Room in Express mode: 

 You can see the Welcome to Setup Wizard screen. Click Next. 

 
 

 Accept the terms of licence agreement and then Click Next. 
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 The Installation Type screen appears, where you can select Express. Click Next. 

 

• Click the information button  for more information on default settings 

 

• In Express installation, the default configuration allows to create a HTTP-based Control Room website hosted 

locally. It uses the default Microsoft SQL Server database instance AACRSQLEXPRESS with default Admin 

credentials: 

Username: aaadmin 

Password: aabots@123 

 Important: For SQL data security, the ‘sa’ account shall be disabled. 
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This instance enables the Control Room Admin to create Non-Active Directory Users. All ports required to run the 

website and services are set to default. Specify an unassigned Port and to continue click Next. 

 
TIP: For a new port, you may have to create rules in Firewall to open the port. 

• If a port is already used, a message appears. For example, when a website port is in use, the following 

message appears: 
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• Conflicting versions of SQL, incorrect configuration, inability to connect to the database server, and/or failure to 

create the default SQL instance will give the following error: 

 

1. Click Cancel and run the AAE_10.3.0_MSSQL_Express_2014SP1.exe.  

TIP: Verify whether it is installed. Also, verify the database instance is correct from the SQL Server 

Management Studio.  

Warning: Ensure the Database Name, Database Username, and Server Instance remain unchanged as 

any change to these will also show the above error. 

2. Rerun the AAE Installation setup once the issue is resolved. 

• If any of the IIS components are not configured/enabled, the Prerequisites window appears. Click Install. 

 
NOTE: An  indicates that the component is not installed. If the prerequisite for Application module is not 

installed, then the setup provides a download link for the module. After downloading and installing this module 
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you must Cancel this setup and then restart the setup once again. For more details, Installing Application Module 

for Win 7 SP1 

• The IIS component is installed automatically. A Windows Command prompt appears; do not close this 

window. 

 

NOTE: If you are a user with Windows 7 SP1 or Windows Server 2008 R2, perform the steps mentioned in the  

Installing Application Module for Win 7 SP1 section. 

 You can opt to create the shortcuts (in the image) by selecting and clearing relevant checkboxes. You can also opt to 

Create a shortcut for Migration Utility. Click Install. 

 
NOTE: All the options are enabled by default. 
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 Setup Status screen appears with a bar that indicates amount of progress in installing Control Room. Once the setup 

status is complete, click Next.   

 
 Click Finish to complete installing the setup.  

a. To Launch Control Room: You can opt for launch the Control Room option if no data needs to be migrated 

from an earlier version (10.x.x) of Control Room. 
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b. To migrate data: You can opt to launch the Data Migration Utility to migrate data from an earlier version 

(10.x.x) of Control Room database. 

 

NOTE: The Control Room application will launch in the default browser if you opt to ‘Launch Control Room’.  

 Remember! Note down the Control Room URL as you will require the same post migration to finish the process of 

configuring Control Room settings. 

You can begin using the Control Room by creating a Control Room Admin. For more information, refer Launching Control 

Room for initial use. 
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3.3.1 Installing Application Module for Win 7 SP1 

In Express Mode of Installation, users with Windows 7 SP1 or Windows Server 2008 R2 need to manually download and 

install the Application Initialization Module for IIS 7.5 

 In the Prerequisites screen, click Download to download the Application Initialization Module. 

  
 In the Application Initialization web-page that is launched in your default browser, click on Install this extension. 

 

NOTE: For Windows 7 SP1 - 32 / 64 bit and Windows 2008 R2 64 bit, you can directly download the extension. Simply 

scroll down on the above web-page and select the download type: 
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• IIS Application Initialization for IIS 7.5 enables website Admin to improve the responsiveness of their Web 

sites by proactively loading and initializing all the dependencies, such as database connections, compilation of 

ASP.NET code, and loading of modules. 

3.4 Custom Installation 

The Custom mode of installation enables you to install the Control Room using your choice of settings. It allows for two 

methods of installation – Standalone and Distributed. 

This method of installation is recommended for production environment as it gives you the flexibility to select 

components for installation – Application or Shared Data & Services or both. 

When you configure Application and Shared & Services components together, it is Standalone mode of installation. When 

you configure these components separately, it is Distributed mode of installation. 

The Shared Data & Services component forms the ‘Data Tier’ of Control Room. On selecting this component, you can 

install the Control Room files repository and WebSocket Service. 

The Application component forms the ‘Application Tier’ of Control Room. On selecting this component, you can install the 

Control Room website, Control Room APIs, and the Scheduler service that triggers/monitors task scheduling activities. 

It is recommended that you use the Distributed mode of installation as with this mode, ‘High Availability’ and ‘Disaster 

Recovery’ of Control Room can be achieved. However, it requires proper planning and multiple iterations of installation. 

• High Availability (HA) refers to a system or component that is continuously operational for a desirably long 

period. 

• Disaster Recovery (DR) involves a set of policies and procedures to enable the recovery or continuation of vital 

technology infrastructure and systems following a natural or human-induced disaster.  

Hence, using the Custom method, you will be able to:  

 Choose which component to install – Application or Shared Data & Services or both 

 Configure the Website - http or https 

 Configure WebSocket – define port and select certificate if https is enabled 

 Define Control Room Database and User Credentials 

 Select the path of shared Repository 

 Define user types – Active Directory or Non-Active Directory 

 Choose an installation path 
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3.5 Custom - Standalone Mode of Installation  

To install the Control Room in Custom – Standalone mode, perform the following steps: 

 Run the Setup for Control Room in Admin mode. 

 The Welcome to Setup Wizard page appears. Click Next. 

 
 Accept the terms of licence agreement. Click Next. 
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 The Installation Type page appears. Select Custom as your preferred installation type. Click Next. 

 

NOTE: For detailed description on each component and how to setup the Control Room for High Availability and 

Disaster Recover, click on the info , the following page is opened. 

  

 Close the browser and go back to the components selection page in the setup. 

• Based on component(s) selected for installation, two modes of installation – Standalone and Distributed – are 

available. This section describes the Standalone mode of installation. 
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 Select both the components – Application as well as Shared Data & Services. 

 
 Click Next.   

a. If any of the pre-requisite for IIS component is not met, the Prerequisites window appears. 

 
 

NOTE: An  mark indicates that the component is not installed.  

b. Click Install. This will install all missing prerequisites. 
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 Once all prerequisites are detected/installed, the Website Configuration page appears where you can provide details 

to host the Control Room website. 

 

 Select HTTP or HTTPS.  

If you wish to configure a secured site, select HTTPS. Refer section on Site Bindings to learn more. 

TIP: Ensure to append the domain name when configuring the Control Room in a multi-domain environment.  

 Type the Web Server Hostname; an IP or Server name.  

NOTE: By default, it displays fully qualified name of the local machine. 

 Insert the Web Server Port number.  By default, the port is set to 80 (for HTTP) or 443 (for HTTPS). 

NOTE: It should be between 1 and 65535. Change the port if it is already in use.  

 Type your Web Server Credentials. These credentials are the ones used for your server’s Application Pool 

Identities. It can be either your local account or domain account where the Web Server shall be hosted. However, 

if you are hosting the Control Room with Active Directory Authentication (Step 12), we recommend that you use 

your domain account credentials for the server’s Application Pool. 
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NOTE: These credentials are required for an Account with Admin privileges. These will be your Windows 

credentials. 

When you type incorrect credentials or if the Active Directory is unreachable, an error appears: 

 

 Click Ok and take appropriate action – type correct credentials or reach out to your IT administrator to check 

Active Directory connections. 

 Click Next in the Website Configuration page. 

 A WebSocket Configuration page appears wherein you must provide details for configuring the Websocket service: 

  

a. If you have chosen HTTP in Website Configurations, only the Port needs to be configured: 

NOTE: By default, it is set to ‘8090’ and is used to host WebSocket Service. Change the port if it is already in use. 

b. For HTTPS, you need to specify the Certificate Path and Password. 

NOTE: It is recommended to use the Personal Information Exchange (PFX) format certificate type. If you do not 
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have a PFX certificate, refer the section on Converting Certificates to PFX Format. 

 

I. Browse to the folder and select the certificate file.  

NOTE: The IIS that will host the Control Room website must have the SSL/TLS certificate installed. SSL/TLS 

certificate enables an encrypted connection between the web server and a browser. It also authenticates 

the identity of the website (Control Room in this case). Refer section on Site Bindings to learn more. 

II. Enter the password for the certificate and the port.  

 Click Next. 

 A Database Configuration page appears. Input required data for configuring the Control Room database. 

NOTE: If you are creating a dedicated SQL user or using an existing SQL user, provide the user database ownership 

privileges to Control Room database. Also, a fully qualified name should be specified as the Server Name.  

E.g. SQLSERVER.MY-DOMAIN.COM\AACRSQLEXPRESS 
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NOTE: The default server provided is ‘localhost’. You can update it to ‘dbserver’.  

a. Enter the port number. By default, it is set to 1433 for Microsoft SQL Server. 

NOTE: It should be between 1 and 65535. If you input an invalid port, the following message appears: 

 

The port can be changed from SQL Server Configuration Manager. Refer the section on Enabling SQL Server 

Configuration for details.  

b. Select the Database Admin type to create an account to access the Control Room database. This must be created 

prior to configuring the Control Room. 

i. Select the option Use Windows Authentication if you have configured Windows users to an existing instance of 

the SQL Server. Here, the Username and Password fields are pre-filled and disabled. You simply input a 

Database Name. 

NOTE: Ensure the database user defined for authentication has ownership privileges to the Control Room 

database. 
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ii. Select the option Use Secure Connection to connect SQL in a secure mode if the SQL Server is configured with 

an SSL certificate. This ensures that there is no compromise of data or any security risk between Control Room 

and SQL Server communication. 

 

NOTE: The Use Secure Connection option remains unchecked/clear by default.  

iii. Enter the Username, Password, and Database Name to connect to the SQL Server using the default database 

Admin credentials. 
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• If you use ‘sa’ as the default database administrator, the following message appears: 

 

To ensure SQL data security, it is important that you create and configure another database account with 

same privileges as the default ‘sa’ account. 

• If there is a connection error to database or if you use incorrect credentials, an error message appears: 

 

Click OK to go back to Database Configuration. 

• If the database name already exists, a warning message appears: 

 

a. Click on No to select a new database. The Database Configuration page re-appears. Input a new Database 

name and Click Next. You must now configure a User Type.  

NOTE: This step is also applicable to Control Room that is installed for the first time. 

b. The Control Room database can be configured to allow creating either Active Directory (AD) users or Non-

Active Directory (non-AD) users. 
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 Select User Type to configure in Control Room. 

 
TIP: Click on the information icon for more information on selecting the type of authentication for your environment. 

 

• Active Directory Users – Use this option when you would want the Client users of a specific domain to be 

authenticated with their Active Directory credentials. 

• Non-Active Directory Users – Use this option when you would want the Client users to be authenticated using 

the Control Room database. 

a. Click OK to return to the User Type Configuration page and select the User type.  

b. Click Next.  
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 The Repository Configuration page appears wherein you can set the Control Room Repository path. This is where your 

Automation Anywhere files are stored. You can opt to change the path in the installer by clicking the browse button.  

 

This configuration is available to users who are installing the Control Room with a new database. 

You must have required access privileges to a folder that you choose as Repository. The default path is set to: 

“C:\Users\Public\Documents\Automation Anywhere Server Files”. 

TIP: You can also opt to edit the path from the Control Room settings, post installation.  

• Click Yes to continue using the same database with default user types and click Next. 

 The Select Destination Folder page appears. Here, you can select the destination folder to install the Control Room 

application files.  

NOTE: By default, Control Room will be installed in C:\Program Files (X86)\ 
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a. Click Change if you want to change the destination folder.

 

• If an earlier instance of Control Room was installed, you can select an existing folder. However, a warning 

message appears: 

 

Select No to create another folder or Yes to use the existing folder. 
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b. Click View Disk Space in the Select Destination Folder page to view the disk space availability. 

 

c. Click OK to return to the Select Destination page.   

 Click Next.  

 A Ready to install the Program page appears. 

 

By default, the Create Migration Utility option is enabled. This allows you to create a shortcut on desktop to access 

the Data Migration Utility that is used to migrate data from an earlier version of the Control Room database.  

For details, refer the AAE Migration Utility Guide shipped with the product. 

 

TIP: Disable the option if you do not have a database to migrate. 

 Click Install 
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 The next page allows you to track setup status. 

 
 Now you can select to launch either the data Migration Utility or the Control Room. 

a. Select Launch Control Room if no data needs to be migrated from an earlier version (10.x.x) of Control Room. 

 
NOTE: The Control Room application will launch in the default browser. 
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b. Select Launch Migration Utility to migrate data from an earlier version (10.x.x) of Control Room database. 

 

 Remember! Note down the Control Room URL as you will require the same post migration to finish the process 

of configuring Control Room settings.  

 Click Finish to complete the installation process. 

This concludes your installation in Custom – Standalone mode. You can now create a Control Room Admin. Refer the 

section on Setting up Control Room Post Installation.   
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3.6 Custom - Distributed Mode of Installation 

Prerequisite:  Before running the setup in this mode ensure that the folder, which will be used to store Control Room files 

repository is shared across the network and the network drive is mapped. 

In a Multi-Domain User environment ensure all components - Application and the Data layer of Control Room are installed 

in the same domain. However, both components should be installed on separate machines.  

Tip: To ensure seamless connectivity between AAE Clients and Control Room, please follow the steps mentioned in 

Section 3.6.3 after installing the Application Layers. 

 

The following describes steps to install the Control Room in Custom mode: 

 Run the Setup for Control Room in Admin mode. 

 The Welcome to Setup Wizard page appears. Click Next. 

 
 Accept the terms of licence agreement. Click Next. 
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 The Installation Type page appears. Select Custom as your preferred installation type. Click Next. 

 
 The Installation Components page appears. 

 

Based on component(s) selected for installation, two modes of installation – Standalone and Distributed are available. 

This section describes the Distributed mode of installation. 
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3.6.1 Installing Shared Data & Services component 

 To install Control Room in Distributed mode, first select the Shared Data & Services component for installation. 

NOTE: You must install the Shared Data and Services component first as it requires database credential input. These 

are then provided for installing the Application component. 

 

NOTE: For detailed description on each component and how to setup the Control Room for High Availability and 

Disaster Recover, click on the info icon. Following page is launched: 

  

 Close the browser and go back to the components page in the setup. 

 Click Next in the Components page.  
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 The WebSocket Configuration page will appear. 

 

a. If you have chosen HTTP in Website Configurations, only the Port needs to be configured: 

NOTE: By default, it is set to ‘8090’ and is used to host WebSocket Service. Change the port if it is already in use. 

b. For HTTPS, you need to specify the Certificate Path and Password. 

NOTE: It is recommended to use the Personal Information Exchange (PFX) format certificate type. If you do not 

have a PFX certificate, refer the section on Converting Certificates to PFX Format. 

 

▪ Browse to the folder and select the certificate file.  

NOTE: The IIS that will host the Control Room website must have the SSL/TLS certificate installed. SSL/TLS 

certificate enables an encrypted connection between the web server and a browser. It also authenticates the 

identity of the website (Control Room in this case). Refer section on Site Bindings to learn more.  
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▪ Enter the password for the certificate and the port.  

 Click Next. 

 A Database Configuration page appears. Input required data for configuring the Control Room database. 

NOTE: If you are creating a dedicated SQL user or using an existing SQL user, provide the user database ownership 

privileges to Control Room database. Also, a fully qualified name should be specified as the Server Name.  

For Example, SQLSERVER.MY-DOMAIN.COM\AACRSQLEXPRESS 

 
NOTE: The default server provided is ‘localhost’. You can update it to ‘dbserver’.  

a. Enter the port number. By default, it is set to 1433 for Microsoft SQL Server. 

NOTE: It should be between 1 and 65535. If you input an invalid port, the following message appears: 

 

The port can be changed from SQL Server Configuration Manager. Refer the section on Enabling SQL Server 

Configuration for details.  

b. Select the Database Admin type to create an account to access the Control Room database. This must be created 

prior to configuring the Control Room. 

I. Select the option Use Windows Authentication if you have configured Windows users to an existing instance 

of the SQL Server. Here, the Username and Password fields are pre-filled and disabled. You simply input a 

Database Name. 

NOTE: Ensure the database user defined for authentication has ownership privileges to the Control Room 

database. 
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II. Select the option Use Secure Connection to connect SQL in a secure mode if the SQL Server is configured with 

an SSL certificate. This ensures that there is no compromise of data or any security risk between Control 

Room and SQL Server communication. 

 

NOTE: The Use Secure Connection option remains unchecked/clear by default. 

III. Enter the Username, Password, and Database Name to connect to the SQL Server using the default database 

Admin credentials. 
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o If you use ‘sa’ as the default database administrator, the following message appears: 

 

To ensure SQL data security, it is important that you create and configure another database account with 

same privileges as the default ‘sa’ account. 

o If there is a connection error to database, an error message appears: 

  

o If the database name already exists, a warning message appears: 

 

i. Click on No to select a new database. The Database Configuration page re-appears. Input a new 

Database name and Click Next. 

 The Repository Configuration page appears wherein you can set the Control Room Repository path. This is where 

your Automation Anywhere files are stored. You can opt to change the path in the installer by clicking the browse 
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button.  

 

a. This configuration is available to users who are installing the Control Room with a new database. 

b. You must have required access privileges to a folder that you choose as Repository. The default path is set to: 

“C:\Users\Public\Documents\Automation Anywhere Server Files”. 

TIP: You can also opt to edit the path from the Control Room settings, post installation.  

 The Select Destination Folder page appears. Here, you can select the destination folder to install the Control Room 

application files.  

NOTE: By default, Control Room will be installed in C:\Program Files (X86)\ 

 

a. Click on Change if you want to change the destination folder. 
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▪ If an earlier instance of Control Room was installed, you can select an existing folder. However, a warning 

message appears: 

 

Select No to create another folder or Yes to use the existing folder. 
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b. Click View Disk Space in the Select Destination Folder page to view the disk space availability. 

 

c. Click OK to return to the Select Destination page.   

 Click Next.  

 A Ready to install the Program page appears. Click Install.  
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 The next page allows you to track setup status. 

 
 Once the installation is complete, the Finish page will appear. 

 
 Click Finish to exit the setup. 

This concludes your installation of Shared Data & Services components for Custom – Standalone mode. You can now 

install the Application components of the Control Room setup. 
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3.6.2 Installing Application component 

 Important: It is recommended that all IIS should have same version of JRE installed i.e.  either JRE with 64 bit or 

with 32 bit.  

 Also, to ensure seamless connectivity between AAE Clients and Control Room, please follow the steps mentioned 

in Section 3.6.3 

 Once the Shared Data & Services component is installed, run the setup on a machine where Application component 

needs to be installed. 

 Select Application component in Installation Components page. 

 
NOTE: For detailed description on each component and how to setup the Control Room for High Availability and 

Disaster Recover, click on the info icon. Following page is launched: 

  

 Close the browser and go back to the components page in the setup. 

 Click Next in the Components page.  
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 If any of the pre-requisite for IIS component is not met, the Prerequisites window appears. 

 
NOTE: An  mark indicates that the component is not installed.  

• Click Install. This will install all missing prerequisites. 

 Once all prerequisites are detected/installed, the Website Configuration page appears wherein you can provide 

details to host the Control Room website. 

 

a. Select HTTP or HTTPS.  

If you wish to configure a secured site, select HTTPS. Refer section on Site Bindings to learn more. 

TIP: Ensure to append the domain name when configuring the Control Room in a multi-domain environment.  

I. Enter your Web Server Hostname; an IP or Server name.  

NOTE: By default, it displays fully qualified name of the local machine. 
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II. Key in Web Server Port.  By default, the port is set to 80 (for HTTP) or 443 (for HTTPS). 

NOTE: It should be between 1 and 65535. Change the port if it is already in use.  

III. Input your Web Server Credentials. These credentials are the ones used for your server’s Application Pool 

Identities. They can be either your local account or domain account where the Web Server shall be hosted. 

However, if you are hosting the Control Room with Active Directory Authentication (Step 9), we recommend 

that you use your domain account credentials for the server’s Application Pool. 

NOTE: These credentials are required for an Account with Admin privileges. These will be your Windows 

credentials. 

 Click Next.  

 A Database Configuration page appears. Input required data for configuring the Control Room database. 

NOTE: If you are creating a dedicated SQL user or using an existing SQL user, provide the user database ownership 

privileges to Control Room database. Also, a fully qualified name should be specified as the Server Name.  

E.g. SQLSERVER.MY-DOMAIN.COM\AACRSQLEXPRESS 

 
NOTE: The default server provided is ‘localhost’. You can update it to ‘dbserver’.  

a. Enter the port number. By default, it is set to 1433 for Microsoft SQL Server. 

NOTE: It should be between 1 and 65535. If you input an invalid port, the following message appears: 

 

The port can be changed from SQL Server Configuration Manager. Refer the section on Enabling SQL Server 

Configuration for details.  
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b. Select the Database Admin type to create an account to access the Control Room database. This must be created 

prior to configuring the Control Room. 

I. Select the option Use Windows Authentication if you have configured Windows users to an existing instance 

of the SQL Server. Here, the Username and Password fields are pre-filled and disabled. You simply have to 

input a Database Name. 

NOTE: Ensure the database user defined for authentication has ownership privileges to the Control Room 

database. 

II. Select the option Use Secure Connection to connect SQL in a secure mode if the SQL Server is configured with 

an SSL certificate. This ensures that there is no compromise of data or any security risk between Control 

Room and SQL Server communication. 

The SQL certificate has to be imported as trusted certificates on all the machines in which Control Room 

Application layer is to be hosted. 

  

NOTE: The Use Secure Connection option remains unchecked/clear by default. 
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III. Enter the Username, Password, and Database Name to connect to the SQL Server using the default database 

Admin credentials. 

 

o If you use ‘sa’ as the default database administrator, the following message appears: 

 

To ensure SQL data security, it is important that you create and configure another database account with 

same privileges as the default ‘sa’ account. 

o If there is a connection error to database, an error message appears: 
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Click OK to go back to Database Configuration. 

o If the database name already exists, a warning message appears: 

 

i. Click on No to select a new database. The Database Configuration page re-appears. Input a new 

Database name and Click Next.  

 You must now configure a User Type. 

NOTE: This step is also applicable to Control Room that is installed for the first time. 

The Control Room database can be configured to allow creating either Active Directory (AD) users or Non-Active 

Directory (non-AD) users. 

a. Select User Type to configure in Control Room. 
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TIP: Click the information button for more information on Control Room Users Authentication Type: 

 

• Active Directory Users – Use this option when you would want the Client users of a specific domain to be 

authenticated with their Active Directory credentials. 

• Non-Active Directory Users – Use this option when you would want the Client users to be authenticated using 

the Control Room database. 

b. Click OK to return to the User Type Configuration page and select the User type.  

c. Click Next. 

 The Repository Configuration page appears wherein you can set the Control Room Repository path. This is where your 

Automation Anywhere files are stored. You can opt to change the path in the installer by clicking the browse button.  

 
This configuration is available to users who are installing the Control Room with a new database. 

You must have required access privileges to a folder that you choose as Repository. The default path is set to: 

“C:\Users\Public\Documents\Automation Anywhere Server Files”. 

TIP: You can also opt to edit the path from the Control Room settings, post installation.  

 Click Yes to continue using the same database with default user types and click Next. 

https://support.automationanywhere.com/


 

Copyright © 2018 Automation Anywhere, Inc.  P a g e  57 https://support.automationanywhere.com 

 

 The next step involves setting up a default port that will be used to share and synchronize application specific data 

across multiple instances of the Control Room in the Distributed Caching Configuration window. 

NOTE: The default port for sharing application specific data is set to 5701 and for synchronization, the Multicast port 

is set to 54327. 

TIP: Ensure to unblock the Multicast port by writing inbound/outbound rules in your firewall for distributed caching 

services. 

 
 Important: Ensure all Control Room instances are being installed within the same Subnet mask. However, if TCP IP 

is configured, you can use different Subnet mask. 

 Click Next.  

 A Select Destination Folder appears. Here you can select the destination folder to install the Control Room application 

files.  

NOTE: By default, Control Room will be installed in C:\Program Files (X86)\ 
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a. Click Change if you want to change the destination folder.  

 

• If an earlier instance of Control Room was installed, you can select an existing folder. However, a warning 

message appears: 

 

 Select No to create another folder or Yes to use the existing folder. 
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b. Click View Disk Space in the Select Destination Folder page to view the disk space availability. 

 

c. Click OK to return to the Select Destination page.   

 Click Next. A Ready to install the Program page appears. 

 

By default, the Create Migration Utility option is enabled. This allows you to create a shortcut on desktop to access 

the Data Migration Utility that is used to migrate data from an earlier version of the Control Room database.  

For details, refer the AAE Migration Utility Guide shipped with the product. 

TIP: Disable the option if you do not have a database to migrate. 

 Click Install 
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 The next page allows you to track setup status. 

 
 Now you can select to launch either the data Migration Utility or the Control Room. 

a. Opt to launch the Control Room if no data needs to be migrated from an earlier version (10.x.x) of Control Room. 

 
NOTE: The Control Room application will launch in the default browser. 
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b. Opt to launch the Data Migration Utility to migrate data from an earlier version (10.x.x) of Control Room 

database. 

 

 Remember! Note down the Control Room URL as you will require the same post migration to finish the process 

of configuring Control Room settings.  

 Click Finish to complete the installation process. 

3.6.3 Important Note:  

In order ensure seamless connectivity between the AAE Clients and the Control Room, the Control Room makes use of 

Hazelcast caching service; which works either in Multicast (UDP) or TCP port. By default, the Control Room uses Multicast 

port.  

For multiple distributed set-ups (multiple Control Room deployments each having multiple application layers all within the 

same network), please follow the following steps. 

Section-A: To continue using Multicast Port (UDP) 

1. Go to the Application server and navigate to the Hazelcast path (e.g. “C:\Program Files (x86)\Automation 
Anywhere Enterprise 10.5\Control Room\Services\hazelcast-3.6.3\bin”) 

2. Stop Automation Anywhere Cache service from the “services.msc”. 
3. Take the back up of existing “hazelcast.xml” file which will be at the folder mentioned in step-1. 
4. Edit the “hazelcast.xml” file 
5. Change the  <multicast-group> ‘s default value 224.2.2.3 to other value, which can be between 224.0.0.0 and 

239.255.255.255.   

a. i.e.  <multicast-group>224.2.2.5</multicast-group> 

6. Start Automation Anywhere Cache service from the “services.msc”. 
7. Repeat steps 1 to 6 for all the Application Layer servers for same environment. 

 

Section-B: To continue using TCP Port 

1. Go to the Application server and navigate to the Hazelcast path (e.g. “C:\Program Files (x86)\Automation 
Anywhere Enterprise 10.5\Control Room\Services\hazelcast-3.6.3\bin”) 

2. Stop the Automation Anywhere Cache service from the “services.msc”. 
3. Take the back up of existing “hazelcast.xml” file which will be at the folder mentioned in step-1. 
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4. Edit the “hazelcast.xml” file 
5. Set the “multicast enabled” tag value to false. 
6. Enabled the “TCP/IP enabled” tag value to true. 
7. In the “interface tag” replace the IP address “12Window.0.1”with Host name of the current Application server. 
8. In the “member-list” tag remove the member tag contenting “127.0.0.1”. 
9. Add the host name of all the other Application Layers (Production APP Layer and DR APP Layer) as member in the 

member-list tag. 
10. Example of the Hazelcast file is shown below: (In this example we are having four Application Layer with the host 

name “Support-PC1.AASPL-XY.com , Support-PC2.AASPL-XY.com, Support-PC3.AASPL-XY.com, Support-
PC4.AASPL-XY.com ” respectively) 

a.  

11. Restarted the Automation Anywhere Cache service of current server. 
12. Recycle the Automation Anywhere Application Pool service of current server. 
13. Repeat the steps from 1 to 12 for all the Application Layer server.  

 

This concludes your installation in Custom – Distributed mode. You can repeat the above steps to install multiple CR 

application instances. 

After finishing the setup, you must create a Control Room Admin. Refer the section on Setting up Control Room Post 

Installation.   
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3.6.4 Setting up Https Site Binding 

Follow below steps to bind Control Room website with secured (SSL) server certificate. This is pre-requisite for configuring 

Control Room in HTTPS mode. 

NOTE: For Control Room that is setup with multiple application layer (IIS), these steps should be repeated for each 

application layer. 

 Important: Ensure the server certificate is available to enable HTTPS site binding. 

3.6.4.1 Importing a Server Certificate 

To import a Server Certificate using the Internet Information (IIS) Manager, you can do the following: 

 Invoke the IIS Manager using the short cut Windows key + Run→“inetmgr” 

 
 Go to the root directory and select Server Certificates in IIS panel in Features View as shown:
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 In the Server Certificates window, click on Import link to import an SSL Certificate. 

 
 Select the certificate and fill in the required details as shown: 

 
 Click OK. 

• The server certificate is imported successfully: 
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3.6.4.2 Site Binding 

Site Bindings can be setup using the Internet Information Services (IIS) Manager, which can be invoked using the short cut 

Windows key + Run→ “inetmgr” 

 

 In the Internet Information Services (IIS) Manager, select Automation Anywhere under Sites and click on Bindings… 

link in the right panel. (marked in image below): 

 

https://support.automationanywhere.com/


 

Copyright © 2018 Automation Anywhere, Inc.  P a g e  66 https://support.automationanywhere.com 

 

 Click on Add button 

 
 In the Add Site Binding window, select Type https, Host name. Provide the port number assigned in application layer. 

 Provide the Hostname. Ensure that this is the same as mentioned in Server Certificate. 

NOTE: If the Host name includes Server Name, enable the Require Server Name Indication option. 
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 Select the SSL certificate. 

 
NOTE: The certificate will be visible only if it has been imported in IIS→ Server Certificates. Refer the steps to know 

how to import certificates.  

 Click OK once done. 

3.6.5 Editing Https Binding 

If you have an existing http binding, you will now have to delete it to keep a single binding. 

 To delete existing http binding, go to IIS Manager and select Bindings for Automation Anywhere website. 

 Select the http site binding and click Remove. 
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 Confirm: 

 
 Now, select the https site binding and click Edit. 

 
 Select the website configured for https and edit the port; specify 443 in the Edit Site Bindings window. 

 
 Save Bindings & restart Application from IIS Manager. 
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3.6.6 Converting Certificates to PFX Format 

If you do not have a valid PFX file, you can convert your existing certificates such as p7b/ p7c to PFX certificates using the 

below method: 

 Generate valid PFX file with all the DNS Names along with Private key. 

• Create dedicated DNS entry to map the hostname with IP in the “hosts” file found in 

“C:\Windows\System32\drivers\etc\” for each Application and Shared servers. 

TIP: Application Server is where the Application layer in installed and Shared Server is where the Database and 

WebSocket configuration is running. 

• Attach the DNS entry into the existing p7b/p7c certificate.  

• Add the DNS entry into hosts file of Load Balancer server 

• Combine p7b/p7c with Private key using IIS 

 You now have the PFX certificate to make WebSocket and the Application Servers secure under Load Balancer. For 

details refer: https://www.ssl.com/how-to/combine-a-private-key-with-p7b-certificate-how-to-create-a-pfx-file/ 

 Uninstall and install the Control Room 

• Uninstall Control Room from the Application Server 

• Install Control Room on the app server with the dedicated DNS name 

• Attach the certificate (PFX) 

• Perform steps a through c for all the other Application Servers (where the Application layer is installed) 

• Uninstall Control Room from the Shared Server (from where WebSocket and Database is running) 

• Install Control Room on the Shared Server with the dedicated DNS name  

• Attach the PFX certificate 

 Configure Application Server with Load Balancer 

 Browse to the Control Room from the Application Server 

 Configure Load Balancer and Web Socket Server Configuration 
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3.7 Repair/Reinstall 

If for any reason, you need to repair/reinstall the Control Room that you had setup earlier, run the installation setup in 

Admin mode.  

 Select Repair/Reinstall option. 

 

NOTE: Use Repair/Reinstall if you want to fix missing or corrupt files, registry entries or update any of the existing 

configuration settings. 

The process of repair or reinstall is similar to installation with a few differences: 

 The Installation Type will default to the previous mode of installation. There is no option to switch from Express to 

Custom and vice versa. 
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• In Express mode, the default configuration set previously will be reused. If the default configuration has 

changed before repair/reinstall, an error log will appear in the Ready to Install screen. 

 

• In Custom mode, there is no option to switch from Application to Shared Data & Services component and vice 

versa. 

 
NOTE: Fields that require input are pre-filled with the last saved inputs. Refer Custom- Standalone Mode of 

Installation to proceed. 
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• In case of Select Destination folder screen, the Change button remains disabled. This ensures that AAE 10.5 

files are on the same path where setup was installed earlier. 

 
 

3.8 Remove (Uninstall) 

 Run the installation setup in Admin mode. 

 Select Remove to uninstall the Control Room from your machine.  

 

 Alternatively, open Control Panel→ Programs and Features, select Control Room 10.x.x and click Uninstall.  
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 Then click Yes to uninstall. 

 
 Click Remove to uninstall Control Room. 

 
NOTE: If Express mode was selected during installation then the below mentioned confirmation message will appear: 

 

• To delete it permanently click Yes; to ignore deletion click No. 

• If Custom mode was selected during installation, then the Remove option will remove the installed 

component – Application or Shared Data & Services or both. 

NOTE: You can opt to remove the Control Room database from the Database Management System manually 

as it shall not be uninstalled. 
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 Click Finish to complete uninstallation of AAE. 

 

Note: Rollback to previous version of Control Room Server(s) (Standalone & Distributed – High-Availability Control Room 

deployment). As 10.5 (SP2) is full setup install there is no rollback possible, you must completely uninstall the current 

version 10.5 (SP2) (refer section 3.8) and install the previous version of AAE Control Room as applicable with complete 

down time. 
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3.9 Cancel Installation 

 Click Cancel at any point in time during installation. 

 Click Yes to exit the current installation. 

 
 Click Finish to complete the cancellation process. 

 
NOTE: To view the Windows installer logs, select the Show the Windows Installer log option. 

.
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4 AAE Control Room - Post Installation Setup 
The Control Room launches in default browser. You must create a Control Room Admin before you can begin using the 

Control Room. Depending upon the user type selected during installation i.e. Active Directory user or Non-AD user, 

Control Room Admin creation differs. 

4.1 Creating the Control Room Admin 

For Active Directory Users, the Control Room Admin creation entails: 

 Verifying the Username within the Domain. 

 Providing Windows credentials, which shall be used by the Control Room Admin to login to the Control Room. 

 Email for sending a link for user verification 

 
 On submitting the information, a confirmation is denoted with a Login screen. 

 Click on Login to configure the Credential Vault.
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For Non-Active Directory Users, the Control Room Admin creation entails: 

 Inputting credentials – Username, First Name (optional), Last Name (optional), email, and password for the Control 

Room login. 

 
 Providing Q&A for enhanced security - Input your choice of security questions and their answers that will be used to 

verify the Admin identity if the password is forgotten: 

 
 A confirmation is denoted with a Login screen. 

  
 Click on Login and enter the Control Room Admin credentials. 

NOTE: You may have to assign a Control Room license after this step, if you are doing a reinstall and your existing 

license has expired. Refer Installing Control Room License section for details. 

 Now you can proceed to configure the Credential Vault. 
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4.2 Credential Vault- An Overview  

The Automation Anywhere Credential Vault is a centralized location wherein sensitive data such as credentials are 

securely stored. It can be configured by the Control Room Admin, immediately post Control Room setup by generating a 

Master Key. Refer section on Configuring the Credential Vault for setting up a Credential Vault. 

An Admin, an IT Admin or any person who has Credential Management privileges can create Credentials in the form of 

Credential Keys, once the vault is opened by using the Master Key.  

 Important: These credentials are encrypted using industry standard FIPS 140-2 approved cryptographic module with 

AES-256-bit encryption and can be accessed by authorized and authenticated users only.  

Apart from providing secure and centralized location for storing credentials, Credential Vault also: 

• Minimizes the possibility of credential fraud 

• Provides an environment to enable improved security 

• Helps adhere to processes and credential management compliance 

• Offers increased automation opportunities with secure data/applications. 

4.2.1 Technical Architecture Diagram 
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4.2.2 Configuring Credential Vault 

On login to the Control Room for the first time, the Control Room Admin must configure the Credential Vault to create 

and store credentials that are required in automation TaskBot(s). 

To connect to this Credential Vault, a Master Key is used.  

 Important: An Admin must generate the master key and keep it in a safe place for future reference. 

 Caution: Ensure you do not lose the key. If you do, you will not be able to create another instance of Credential Vault or 

even delete one. In fact, you will not be able to access the Vault or the Control Room. 

To configure your Control Room’s Credential Vault, follow the steps mentioned below: 

 Login to Control Room as Admin.  A Configure Credential Vault page appears. 

 Click on Get Master Key button to generate the master key, which allows you to connect to the Credential Vault.  

 
 You can see the master key  

 
 Select either Express or Manual mode of connecting to the Vault. 

• Use the Express mode if you want the Control Room to store the master key and automatically connect to the 

Vault.  

 

NOTE: This mode is less secure and not recommended for Production environment. 
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• Use the Manual mode if you want to secure the master key by yourself and use it to connect to the Vault 

manually.  

 

NOTE: This mode is more secure and recommended for Production environment. 

• Whether using Express or Manual mode of connecting to the vault, you must ensure to copy and paste the 

master key that you had secured earlier and Click Submit. 

 

 Important: Do not modify the master key in any manner as you cannot connect to the Control Room with a 

key that is modified and considered invalid (see message): 

 

 Click  to navigate to the Getting Started page.  

TIP: You can choose to switch between modes from the Control Room Settings page, if required at a later stage. Refer the 

section on Control Room Settings on how to switch modes. 
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5 AAE Control Room - Getting Started 
If Control Room is installed in Express mode or Custom – Standalone mode, then the Getting Started page will be displayed 

upon first login of Admin account. 

However, if Control Room is installed in Custom – Distributed mode, then the Getting Started page will be displayed post 

configuring the Control Room Settings for Load Balancing. 

The Getting Started page that is visible to the Admin, displays quick steps on how to use the Control Room. 

 

5.1 Configuring Control Room Settings  

5.1.1 Settings for Standalone Installation 

When the Control Room is configured using the Standalone mode of installation, you can opt to update the Repository 

Path.  

 

 

While updating the repository path, you must ensure that the files in the earlier repository path are manually copied to 

the newer one. Also, you can map the path to a folder for which you have access privileges. 
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5.1.2 Settings for Load Balancing (Distributed Installation) 

If Control Room is installed in Express mode or Custom – Standalone mode, then the Control Room Settings does not 

require configuration at the first login of Admin account. 

However, if Control Room is installed in Custom – Distributed mode then post the first login of Admin account you will be 

prompted the Control Room Settings page, which you must configure else you will be restricted from navigating the 

Control Room application. 

 

 

 Repository Path:  Provide the path of Control Room physical files repository. This must be a shared path so as to allow 

the Application to access the repository. 

• WebSocket Service:  Provide the hostname and port of the machine where WebSocket service is running. 

• Control Room Access URL:  Provide the hostname and port or URL of the machine hosting Control Room 

application or the Load Balancer through which the Client requests are routed to the application. 

• Client Service Communication Port: Control Room Admin can configure the port number. Although, the 

default port is displayed as 8001; the Control Room Admin has the flexibility to edit the default port number 

and save it.   

 Click Save to save the configuration settings. 

 Upon successful configuration you will be displayed the Getting Started page. Refer section on Getting Started for 

details.  
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5.2 Installing Control Room License 

You can install a license during evaluation, post-evaluation or if you have purchased more licenses to support growing 

number of Client users. 

5.2.1 Installing a purchase license during evaluation term 

NOTE: You can evaluate Control Room for 30 days. 

 As a Control Room Admin you will be able to install licenses using any of the following methods:  

• By clicking the Install License button in the Evaluation window. 

 
Or 

• By selecting Install New License link in Settings→ License Management. 

 

 Next, choose the purchase license file from a folder: 
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 Select the appropriate file. 

 
 Click Upload License.  

 You are informed about successful installation of license through a message. Click OK to confirm.  

 
NOTE: You need to re-login to Control Room after the license is uploaded successfully. 
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5.2.2 Installing a license on completion of evaluation term 

In License Management, the Control Room Admin can also view how many days are remaining for the license to expire. 

If more than 30 days are left for license expiry, the License Management screen will be seen as follows: 

 

If less than 30 days are left for license expiry, the License Management screen will be seen as follows: 

 

On completion of the evaluation term, Control Room Admin can continue using the purchased version only after the 

Control Room Admin installs appropriate license. 
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When less than 30 days are left for license expiry, you will be notified on the Dashboard.

 

NOTE: The license expiry information will be seen on your Dashboard only if you have Admin privileges. 

Admin can install a new license from License Management console. Learn More.  

However, if your Control Room License has expired before you were able to install a new license, then you will be shown 

the below screen during Control Room login: 

 
To purchase a license, the Control Room Admin will have to contact Automation Anywhere Sales on 

sales@automationanywhere.com. 

After the completion of your order, you will receive an email from Automation Anywhere containing a registration license 

file. Download and save the file to a desired location on your computer.  

Once you have uploaded the valid license file, you will be able to login to the Control Room and continue monitoring 

activities.   
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5.3 User Roles and Privileges 

Launch the Control Room in your default browser.  

TIP: Use the link that’s displayed on install setup completion.  

You are now ready to create roles and assign necessary permissions to the users. 

NOTE: Examples given in this document are for reference only. You can create and define roles according to your 

organizational structure and requirements. 

Activities and access to Control Room for Users (Admin, Clients and non-Clients) are governed by the role defined for 

each. The role based accessibility model ensures each User has controlled-access, to view information or data that is 

relevant to the role assigned by the Control Room Admin.  

User Roles and relevant privileges are assigned from the Security page. 

 

You will find pre-defined roles in the Control Room. Those are the system roles.  

• The Admin permissions in Control Room are granted to the Control Room Admin by default.  

• Basic permission is essentially for Users that have been imported from earlier versions (8.x.x and 9.x.x) of 

Control Room to the browser based Control Room, using the migration utility. Such users have access rights 

to the My Tasks folder only. 

NOTE: From AAE Control Room 10 SP2 (product version 10.5.0), two new system roles have been introduced – 

IQBotServices and IQBotValidator. Hence, if you have upgraded from Control Room 10.x version and roles with same 

names have been defined, it is recommended that you delete custom defined roles. You can create new roles with 

same permissions instead. 

  

https://support.automationanywhere.com/


 

Copyright © 2018 Automation Anywhere, Inc.  P a g e  88 https://support.automationanywhere.com 

 

5.4 Creating New Roles and Assigning Permissions 

To define a new user Role, click Create New Roles. 

 

In the Create Role page input the required information: 

 

 You can choose to assign permissions based on user roles in your organization. 

For instance, you can permit the new User to manage a repository only; in which case, you can select the 

Repository Manager folder. 

 You can then assign the User access rights that could include any or all - Upload, Download, and Delete 

permissions for different folders. 

For instance, you can assign a User Upload and Download permission to the My Tasks folder only. 

TIP: Some users such as Bot Runner(s) - Users who use Enterprise Client to simply run TaskBot(s), can be given 

'Folder Access Rights' only. 

 Save the new role. 
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 Verify whether the User Role has been created in the Roles and Permissions list. The User Roles are listed in the 

chronology that they are added and updated. 

NOTE: Control Room users with task run and scheduling permissions can run and/or schedule TaskBot(s) only 

on those Bot Runner(s) that are assigned to their role. Refer the article on Assigning Bot Runner(s) to 

Run/Scheduling Role. 

 

5.5 Managing User Permissions 

You can reassign or revoke permissions to the user. 

• To view permissions and access rights available to an Admin user, click the information icon . Similarly, you can 

also view permission and access rights for the Basic role.   

NOTE: Though in edit mode, you will not be able to update the permissions and access rights of Admin and Basic. 

• To edit the User roles and permissions, click on  and  to delete. 

• To return to the Dashboard, click on . 

Refer the article on User Roles and Permissions in the online knowledge base for details. 
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5.6 Roles and Permissions Matrix 

The roles and permissions matrix published here will enable you to create a combination of roles and permissions that 

suit your organizational requirements. 

Role Description 

User Management User can add, update and/or delete Control Room users. 

Repository Manager 
User can run, force unlock and/or set production versions of TaskBot(s) available in 
the Control Room repository. 

Task Scheduling 
User can add, update, delete and manage all TaskBot(s) for scheduling to Bot Runner 
machines. 

Client Management 
User can view the Clients that are registered to the Control Room and export Client 
details to a CSV file, if required. 

Roles and Permissions 
Management 

User is granted privileges to manage roles and permissions to other Control Room 
users. 

Audit Trail User can review all Control Room relevant activities. 

Credential Manager User can create, edit, and delete credentials in the Control Room 

License Management User can allocate/deallocate licenses to Client users. 
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5.7 Creating Users in the Control Room 

Client User management involves creating users after defining specific roles as soon as the Control Room is hosted. These 

users can be either Non-Active Directory Users or Active Directory Users, as configured during installation. 

Ideally, a Control Room Admin or Users assigned Admin rights can create Users/Clients. These are then assigned roles 

depending upon access privileges.

 
 

 To start creating a user, click on Create User under Actions 

 
 Input the required information. 

TIP: Firstname and Lastname are optional. If you do opt to have Firstname and Lastname, you are allowed to include 

Numbers, Spaces ( ), Period (.), Hyphen (-), and Underscore (_). 

 For a Non-Active Directory User, provide information in each field: 
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 The information for an Active Directory User gets auto-populated when you input the User Name and click Check 

Name: 

 
NOTE: If the Control Room is configured for a multi-domain environment, the Domain is auto-populated with the 

domain name that you append for the user. 

 Select either one or multiple Roles from the list as required. To delete the selection, use the cross-mark. 

 An email is sent wherein the user will use the link to: 

• Verify the email id and set the Control Room access password, if the Control Room is configured for Non-

Active Directory users. 

OR 

• Verify the email id, if the Control Room is configured for Active Directory users. 

 Now allocate licenses based on the role by clicking Allocate License link;  

• For instance, a Bot Creator role can be allotted a Development license: 

 
• While a Bot Runner role can be allotted a Runtime license: 
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• Or only a Control Room user would not require any Client license: 

 
NOTE: If no slots are available for license usage, you are displayed: 

 
 Click Save. 

TIP: You can choose to switch a user type i.e. from Development (Bot-Creator) to Runtime (Bot-Runner) or vice versa as 

per organization’s automation requirements by updating the license type from License Management. 

5.8 Setting User Password 

Control Room Users can change the password from within the Control Room by clicking on Change Password: 

 

Set the new password: 

 

The Active Directory user will be able to login directly to the Control Room. However, user may have to input the Windows 

Credentials in case the browser settings are set to prompt. 
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5.9 Forgot Password? 

NOTE: Applicable to Non-Active Directory Users only 

The Control Room Admin can reset the password for login using the Forgot Password? link: 

 Click on the Forgot Password? link provided beneath the Login button. 

 
 You are displayed a confirmation message for resetting your password. 

 
 Click the Reset your password link in the email that you have received. 

 
NOTE: If you have not configured outgoing mail server, you will not receive an email notification. Instead, you will be 

displayed the set of ‘Security Q&A’ on clicking ‘Forgot Password’. 
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 In the Security Q&A section, input the required information. 

 
 Click Submit and you will be redirected to the Login page wherein you can set your password: 

 
 On clicking Submit you will be able to login to the Control Room using the new password. 
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5.10 Updating User Details 

The Control Room Admin can update user details. User details such as alias names, email and roles can be modified; users 

can be activated, deactivated or even deleted if necessary. 

To update user details, go to User Management, select the user and click . 

 

Update required information and click Save. 
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NOTE:  

• If you have not configured Outgoing Mail Server, you will be allowed to set the password for a User who has 

forgotten the same. The User can then reset it during Control Room login. 

 

• You can also choose to reallocate license to switch user from Bot-Creator (Development) to Bot-Runner 

(Runtime) or vice versa by clicking on .  Refer section on License Allocation for more information.  

To activate a user, click ; to deactivate click  in the Actions column. 

NOTE: To enable a Client User to register to the Control Room, it is important to 'Activate' the user. Use the 'Deactivate' 

option only if the Client user needs to be made inactive temporarily. 

You can verify whether a user is Verified and Registered in License Management as shown:  
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5.11 Installing and Allocating Licenses in Control Room 

The Control Room Admin manages the installation, distribution, and allocation of licenses to Clients. Two aspects of 

Licensing can be managed from the License Management console: 

 New License Installation 

 License Allocation  

 

  
 

NOTE: Purchase and subsequent license allocation is subject to the type of Enterprise Clients that need to be defined 

– Bot Creator (Development) or Bot Runner (Runtime). 

5.11.1 Viewing License Usage 

Once the license is installed, you can verify the Client usage status: 

 

Here you can view: 

• License Type - Basically you can allocate licenses to two Client User types – Bot Creator (Development) and 

Bot Runner (Runtime). 

Bot Creator Clients are the ones who are given the privilege of creating TaskBot(s) in Enterprise Client. They can be 

allotted Development license type. 

Bot Runner Clients are run-time users who have permission to run TaskBot(s) only. They can be allotted Runtime 

license types. 
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• Purchased - Displays the number of licenses that have been purchased for Development Clients and Runtime 

Clients.  

Bot Creator Client Users can be allowed to create TaskBot(s) that could include IQBot and/or MetaBot if the required 

plug-ins have been installed. 

The Bot Runner Client Users can be allocated licenses to enable the Scheduling Manger - User with scheduling 

privileges, to run TaskBot(s) on Runtime Client User machines. 

You can allocate licenses to Bot Runner(s) depending upon your requirements. For instance, you could either 

allocate all Runtime licenses to TaskBot Clients or divide the licenses between IQBot and/or MetaBot if the plug-ins 

have been installed. 

• Used - Displays the number of licenses that have been consumed by Development and Runtime Clients 

including IQBot(s) and MetaBot(s). 

5.11.2 App Usage Status 

You can monitor your App - Analytics and BotFarm Usage status in License Management. 

 

TIP: You need to register your applications App Management to be able to monitor your app usage. 

Here, you can view: 

• Application License Type - The status of licenses for Analytics and BotFarm are displayed in the Applications 

column. 

When you purchase a license for Operational and/or Business Analytics, the status under Purchased column is 

displayed as Yes. 

The BotFarm license needs to be purchased separately. It also displays Yes status if purchased. 

• Usage Status - The status for Operational and Business Analytics is based upon license allocation to 

AnalyticsExpert and AnalyticsConsumer. 

NOTE: The Operational Analytics licenses is assigned to the Analytics Expert, while the Business Analytics license is 

assigned to the AnalyticsConsumer. Refer the article on Managing Roles and Permissions for details. 

Similarly, the Used column shows Yes as and when a license is assigned to a BotFarm Agent.  

• Client Block of Hours - This indicates the hours purchased and utilized by BotFarm Agents. 

  

https://support.automationanywhere.com/
https://support.automationanywhere.com/entries/96329478-Allocation-and-Management-of-Licenses


 

Copyright © 2018 Automation Anywhere, Inc.  P a g e  100 https://support.automationanywhere.com 

 

5.11.3 License Allocation and Re-allocation 

You can allocate and reallocate licenses to your Clients from the License Management view. Here, you can allocate or 

reallocate licenses to users that are already created. 

The User list depicts all the Clients that are registered to the Control Room. 

 

NOTE:  

• A Client cannot connect to the Control Room until the user has been allocated a license. Once the Client logs 

in, that user is registered to the Control Room and the license is indicated as consumed. 

• You can choose to switch Client user types i.e. Development to Runtime or vice versa. Simply click on  to 

change the user type. 

 To allocate a license to a Client, click on  to launch the Client License Allocation window and select the Client type: 

• You can select Development type for Bot-Creators: 

 

• You can select Runtime for Bot-Runners: 
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• None, when you want to either not allocate a license to the user i.e. create a Control Room user only or to 

release an existing license in order to convert a Bot-Creator to Bot-Runner (works the other way round also): 

 

 Click to Save. 

NOTE: If licenses are unavailable for consumption, you will be notified on license allocation: 

 

 You can also modify the type of licenses allocated by clicking .   

• If you modify a Bot-Runner Client to Bot-Creator, the existing schedules for that Client will be deleted. 

 

• If you select the None option for an existing Client user who has been allocated Development or Runtime 

license, the license will be released: 

 
The user will, however, not be able to login to the Client. 
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 A success message indicates the updates are saved: 

 

TIP: If you run out of licenses, contact support@automationanywhere.com 

5.12 Session Expiry  

To preserve web server's resources, the Control Room’s session expires after certain time of inactivity. By default, Control 

Room session will expire after 20 minutes of inactivity.  

 

To continue monitoring the Control Room, Non-Active Directory users must re-login after session expiry.  

NOTE: After session expiry, the Active Directory users will be auto-logged in to the Control Room and the login entry can 

be seen in Audit Trail. 

Users connected to the Control Room through Client will be disconnected after some time: 

 

You may also get Session Expired screen if there is Multiple concurrent logins to Control Room using a user’s credentials 

on the different machine / browser.  

For Instance, User1 successfully login Control Room in Browser1/Machine1, and just a minute later if User2 successfully 

login in browser2/Machine2 using User1 login credentials, then User1 will be shown Session Expired page on click of his 

next action in Control Room. 
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5.13 Configuring Version Control  

To manage controlled edits of files that could include TaskBots, VisionBots, Reports, and Workflows, you can configure 

Version Control in Control Room Settings page. 

The Control Room is tightly integrated with SubVersion version control system so that the versioning, checkin/checkout 

and other functionality can be leveraged with ease for all files. 

5.13.1 Version Control Pre-requisites 

For Version Control to be enabled and integrated from Control Room, it is necessary that SVN (SubVersion) should be 

installed and configured. 

NOTE: Automation Anywhere supports Subversion v1.8.13 and v1.8.14 with Visual SVN Server 3.3.x. 

An SVN Admin user should be created with required permissions. 

An SVN repository should be created, which can be used to store all version control files. 

Control Room will be the basis of communication with SVN. Clients will not communicate with SVN directly. 

NOTE: Once the Control Room integration with SVN is up and running, all communication for version control operations 

from Enterprise Client to SVN will take place via Control Room only. 

5.13.2 Enabling Version Control 

To be able to use Version Control you need to Enable the feature from the Control Room. Follow the below mentioned 

steps to enable Version Control: 

 Click on  button on the top right on the Control Room panel and select Control Room Settings. 

 

 
Following image shows the default view of the Control Room Settings. 
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 Click on Version Control Settings tab.  

  

 Input the required details and click Connect. 

 Once the connection is established successfully, the Server path will be auto-populated. 

5.13.3 Uploading the Base Version 

Before enabling Version Control, it is essential to upload a base version of all the files in the repository. Base version 

essentially serves as a basis for defining change and all the Version Control operations will be done on the defined base 

version only.  

Though creating base version is optional, for existing users it is highly recommended as the first step towards versioning. 

When a Client performs the first version control operation on a file, it will automatically be reflected in the Version 

Control Repository.  

 

NOTE: The upload Date and Time are displayed after the files are uploaded to SVN. 

The total files on SVN will be same as the Repository Manager. 

NOTE: Uploading base version may take time since it depends on the size of local repository being uploaded. Once the 

uploading is completed, the timestamp is set beside the Upload files link for the last upload process. 
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5.13.4 Un-map and Remap Server Path to Local Path 

In case, your SVN Repository has moved to a new address/path, you will need to change the mapping of your server path 

to local path (application path). 

NOTE:  

• When changing only the URL Parameters, the current mapping will remain intact; however, a connection to 

the new URL will be re-established.  

• When changing the path for SVN repository, the current mapping will be un-mapped and the new mapping 

will be established. 

Remember, while re-mapping the SVN Repository should not comprise any file(s). 

To change the server path, simply change the Path field to another SVN repository and click OK. In the ensuing message, 

select Yes to continue. 

 

On confirmation, the existing mapping will be removed, all checked out files will be forcefully unlocked by the Control 

Room Admin and the new mapping will be created. 

If the change in server path mapping fails, then an error “Unable to map the new Server path with Local path. Verify your 

path settings” will be displayed and the old mapping will be restored. 
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5.13.5 Verifying Version Control is enabled in Client 

To confirm that Version Control has been integrated properly, simply launch the Enterprise Client.  Learn how to launch 

the Client.  

If Version Control is enabled, then you can see  sign in front of all the new TaskBot(s), which were not available on the 

Control Room when base version was uploaded.  

NOTE: indicates a new Task.  

 

 

5.13.6 Using Version Control in Enterprise Client 

With Version Control enabled you can perform controlled edits to your files - TaskBots (including IQBots), Docs, Reports, 

and Workflows.  

 

Use Version Control to perform following operations:  

 Create: You can create a new file in the local repository. A plus sign ( ) indicates the file is new.  

 Edit: You can edit a file only if it has been Uploaded and Checked Out.  
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 Check Out: A file that already exists in the server repository can be checked out for editing. A check mark (  ) 

indicates the file is checked out 

 Upload: Post editing, you can upload a file to the server repository with comments. No prefixed icon/sign denotes a 

successful upload.  You can also upload files from a specific folder from the TaskBot(s) List/Repository.  

 Version History: You can view revisions to a file and if required, roll back any updates.  

 Copy and Rename: You can make a copy of a selected file in the local repository provided it has not been checked out.  

 Delete: You can delete a file from the local repository provided it has not been checked out. 

5.13.7 Disabling Version Control 

The Control Room Admin has the privilege of disabling and re-enabling the Version Control feature. 

Clicking Disable will not allow Clients configured to the Control Room to perform versioning operations such as Check Out, 

Upload Files, and Upload Comments & view Version History. 

 

NOTE: It is possible to re-enable Version Control at a later stage if required. Simply click 'Enable' to continue using 

versioning operations from where you left off! 

 

NOTE: Disabling Version Control will also disable the Configure and Upload files link. 
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5.14 SMTP Mail Server Configuration 

This configuration is required for email notification from Control Room to Control Room Users. 

NOTE: This setting is optional. However, we recommend configuring SMTP Mail Server as the Control Room Admin will not 

be able to convey important information regarding account creation, credentials, resetting password and account 

deactivation, separately. 

For SMTP mail server configuration, you will need the following information:  

 Host Name 

 Port Number 

 Email Id 

 Username  

 Password 

 

Select the My Server uses a secure connection option to establish a secure connection to the SMTP server. 

Alternately, in case the SMTP server does not require authentication, disable the My server requires authentication option 

to allow the Control Room to bypass authentication to the SMTP Server for sending email notifications.  

NOTE: Both options are enabled by default. 

On saving the configuration, the Control Room verifies the authentication details and provides the required response. 

5.15 Configuring the Credential Vault  

As mentioned earlier, to configure settings for Credential Vault, an Admin needs to choose between Express or Manual 

mode during setup and can opt to switch modes in the Control Room Settings, later. 

 Important: If the Control Room is setup using Distributed Mode, you can switch modes only after configuring the 

Control Room for Load Balancing.  

 

 Important: Store the master key at a secured location. Any modification or loss may result in your losing complete 

access to the Control Room. 
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 Express Mode - Use this to auto connect to the Credential Vault with the master key that is stored in the system 

during Control Room configuration. 

 Manual Mode - Use this to manually connect to the Credential Vault using the master key that was available during 

Control Room configuration.  

NOTE: You will have to provide this key every time you start/re-start the Control Room. 

While switching modes, you must provide the Master Key in the field and click Save for the changes to take effect.  

 Important: For some reason, if you must retrieve the master key, it is stored in the ‘CredentialVault.dat’ file of the 

repository path provided you have configured directly in Express mode or have upgraded from AAE 10.2.0 to the current 

version. 

E.g. C:\Users\Public\Documents\Automation Anywhere Server Files\CredentialVault.dat 

A successful switch is denoted with: 

 

5.16 Setting the Client Services Communication Port 

The port number is configurable by the Control Room Admin. An Admin has the flexibility to edit the default port number 

and save it. 

NOTE: The default port will be displayed as 8001.  

 

Also, Control Room admin will receive a prompt for confirmation before saving any changes to the port 

 

If the newly defined port is blocked on the Client side, then a notification is prompted to the Client user informing that the 

port is blocked. Also, a pop-up message appears as "Port Is Blocked - Client Communication Services Port Blocked - 

Contact Control Room Admin." 
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If a port is in use by some other services then a pop-up appears, "Port Is in Use – Client Communication Services Port Is in 

Use - Contact Control Room Admin." 

 

When you make changes in the port number an audit entry appears in the Control Room as "Client Communication 

Services Port is changed." 
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6 AAE Client - Prerequisites 
This section helps you determine whether your system has the proper hardware and software to install Automation 

Anywhere. Before installing this version of Automation Anywhere, verify that your environment supports the following 

requirements. 

6.1 Operating Systems 

(32-bit and 64-bit OS versions are supported.) 

Operating System Edition 

Microsoft Windows Server 2012 R2 Standard Edition 

Microsoft Windows Server 2012 - 

Microsoft Windows Server 2008 R2 Standard Edition 

Microsoft Windows 8.1/ 8 Pro / Enterprise Edition 

Microsoft Windows 7 SP1  Standard / Professional Edition 

Processor speed: Recommended – 2.6 GHZ+ with 4 Cores and above 

RAM: Recommended:  

• For AAE Client - 4 GB or higher  

• For AAE Client with MetaBot Designer License - 8 GB or higher 

Hard Disk capacity: 300 MB of free hard disk space for installation. 

NOTE:  

• On an average, an Automation Anywhere script is approximately 100-150 KB. Additional free disk space is 

required to develop automation projects, as Automation Anywhere creates temporary files like screenshots, 

server logs, audit files etc. during the execution of the automation scripts.  

• The actual free space required increases with the project size and hence it is recommended to have at least 

40-50 GB of free disk space to implement long term projects. 

• You might have to upgrade to a higher configuration post installation depending upon product usage. For 

instance, in MetaBot Designer - generation of log files, Logic creation, and so on might require more disk 

space later. 
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6.2 Browser Support 

Browser Version 

Internet Explorer 10 and 11 

Chrome* 49 and above 

Firefox 45, 46, and 47 

* Automation through Chrome is not supported in MetaBot Designer. 

6.3 Plugins 

Plugin Version 

Silverlight 5.1.x 

Adobe Flex 24 

Internet Explorer 11 11.0 

Chrome 49 and above 

MODI 12.0 

TOCR 5.0 
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6.3.1 Region Format and Settings (Language Locale) 

You can verify and update the Region Format and Settings i.e. the Language Locale from Control Panel → Region. 

• To update your Region Format, select the Format tab. 

a. It is recommended that you select English (United States) as your Region Format 
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• To update your Language Locale, select Administrative → Change system locale…  

  

a. It is recommended that you select English (United States) as your Region Settings 
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6.4 Other Requirements 

 .NET Framework 4.6 and 4.6.1 (for Windows 8.1 and Window Server 2012 R2)  

Note: The .NET Framework 4.7 update is also supported 

1024 x 768 or higher resolution monitor 

Mouse or another pointing device 

Technology Support: 

• Windows 

• OCR 

• HTML 

• .NET 

• WPF 

• Flex 

• Silverlight 

• Java 1.6 onward (Desktop and Web) 

6.5 Synchronization Time between Client and Control Room 

To synchronize the time between the Client and Control Room, enable the Network Time Protocol (NTP) settings on your 

network. 

NOTE: For more information regarding modification of the NTP settings for your network, contact your system admin. 
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7 AAE Client - Installation 
Using the Client setup, you will be able to install or upgrade the following components: 

 Client 

 MetaBot Designer 

 Internet Explorer 11 plugin (optional) 

 Chrome plugin (optional) 

 Java Plugin (optional) 

 

NOTE: If a previous version of AAE Client is installed on your computer, you can upgrade to this version with the help of 

the installer. Refer Upgrade section for details. 

Important: It is recommended that you - 

 Run the setup in Admin mode as while installing the application some system updates are made in the services and 

registry. 

 Ensure Full Control permissions are granted to users, if during installation you choose to store the Automation 

Anywhere files namely Automation Anywhere Client Files, Automation Autologin, and Automation Schedules in 

Program Data.  

• You can provide permissions in C:\ProgramData → Properties → Security → Advanced → Permissions. This is 

to ensure the end user can edit the application files that are used during runtime, which are stored in the 

Program Data folder.  

 
• Note that you do not need to provide separate permissions to users if the application runtime files are to be 

stored in Public Documents folder. Full Control permission to users are required only if you store application 

run time files in Program Data. 

Refer details in steps on Additional Configuration. 
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To begin installation of Client, follow the steps given here: 

 Run the Setup for Client in Admin mode. 

NOTE: If you have installed a previous version of the Client, ensure you perform a complete uninstall. This can be 

done from the Control Panel → Programs and Features. 

 

 
 Click Next. 

 Accept the terms of license agreement. 

 
 Click Next. 
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 Select the Destination Folder where you want the setup to install files.  

NOTE: The default location for the Setup Installation is C: Drive. 

 
 Click Next to install the Setup in the default folder, click Next.  

However, if you wish to install the Setup in different folder, click Browse.  

NOTE: If Automation Anywhere Enterprise already exists and you are upgrading to the newer version, then you can 

choose to install the Setup files in the existing folder. 

 
 Click OK. 
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 The Ready to Install the Program screen appears in which you can install plugins that are required for automation.  

 
• This screen enables you to create the AAE Client desktop icon and install IE-11, Chrome and Java plugins to 

automate those technologies and browsers. By default, Create Desktop Icon, IE 11, and Chrome are selected. 

 

TIP: Clear/uncheck the options that you do not want to include. E.g. clear ‘Create Desktop Icon’ if you do not 

want a shortcut created for the application on your desktop. 

 

To install the Java Plugin, select the option. It is installed only on confirmation: 

 
You can also install/reinstall Java Plugin from the Tools → Options → Plugin Settings in Client or silently install 

it from the command line. For details refer Using Plugin Settings. 
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NOTE: If you are using JRE versions 6 and later, Java applications can be automated without installing the AAE 

Java Plugin as AAE provides support to automate dynamic Java Applications (Java Applications that run from a 

packaged JRE). 

 

NOTE: AAE Plugins for Adobe Flex and Microsoft Silverlight will automatically be installed if Adobe Flex 

debugger and Microsoft Silverlight is installed on the machine. 

 

• Click on  button, this opens an Additional Configuration page where you can configure the Control 

Room URL and select a folder for runtime files: 

i. Control Room URL (optional): This option ensures that when you launch AAE Client for the first time, 

the login window automatically populates the Control Room URL. When you upgrade, this will show 

the existing URL. 

 
NOTE: You need to ensure that it is clean installation of Client for the above given approach to work. 

 

ii. Folder for Runtime Files: This option allows you to choose the default folder to store folders and files 

that are used when the application is running. 

• Public Documents – This option is selected by default. You do not need separate permission 

to store run time files in this folder. 

• Program Data – You can choose this option if you are granted full control permission to this 

folder. 

a. When you are installing the Client for the first time and choose to store runtime 

folders and files in Program Data, those are created in Program Data folder. 

b. However, if you are upgrading the Client, the existing folders and files are copied to 

the Program Data folder from Public Documents. 

 Important: If you switch back to Public Documents after choosing Program Data, 

the folders - Automation Autologin, Automation Schedules, and Automation 

Anywhere Client Files need to be copied to the Public Documents manually. 

c. If Program Data was chosen while installation, during a reinstall, ensure that select 

Program Data again as by default Public Documents is selected. 
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 Click Install. 

 
 By default, the application can be launched. Clear the check box for the launch option if you do not want to launch 

the Client. Click Finish. 

 
 Important: If any of the dependency services such as AAAutoLoginService, AAClientService, and 

AAESchedulerService are not running, you will have to manually start those from the Services tab in the Task 

Manager. 
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7.1 Upgrade 

If a previous version of AAE Client is installed in your computer, you can use the AAE 10.5.0 setup to upgrade the Client. 

You no longer should carry out the 2-step process; uninstalling the previous version of AAE Client and then installing the 

10 SP2 AAE Client. Instead, run the AAE 10.5.0 setup in Admin mode to upgrade: 

If you already have a previous version of Client installed (e.g. 10 LTS, 10.x), a message will be displayed as shown below. 

Click Yes to upgrade. 

 

Refer Installation and Upgrade Notes of Release Notes document for details on upgrading from various versions to AAE 

10.5.0. 

7.2 Remove (Uninstall) 

If for any reason you wish to uninstall AAE, go to Control Panel → Programs and Features. Select Automation Anywhere 

Enterprise Client and click Uninstall.  

Alternatively, you can choose to remove the Automation Anywhere Enterprise by launching the Setup Wizard and 

selecting Remove. 

 

7.3 Repair 

Use the Repair option to re-install all the program features that were installed during the initial setup run. 

To Repair, follow the steps mentioned below:  

 Launch the AAE Setup Wizard and select the Repair option. 

 Click Next. 
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7.4 Silent Install 

Silent Install, also known as unattended installation, runs the entire installation process in the background, without 

requiring user interaction or displaying messages. 

To do this, create a file of installation response file and send the file to machine where you wish to install the Client. 

The installation response file is created with the name of Setup.iss. This file contains the Install/Uninstall steps that have 

been recorded during the process.  

Refer Creating Response File for details. 

7.4.1 Creating a Response File 

To create the response file, perform the following steps: 

 Identify the directory containing the AAE Setup. For instance: 
"D:\Setup_Files\Automation_Anywhere_Enterprise_Client_10.5.exe" 

You must create a response file for Client. In Windows command prompt key in: 
"D:\Setup_Files\Automation_Anywhere_Enterprise_Client_10.5.exe" /r 

This will record the installation steps in the response file 'Setup.iss' as you perform them. 

TIP: Once the installation is complete, send the response file to the machine where you wish to install the Client, 

together with the setup files. 

NOTE: Setup.iss file is by default written to the %SystemRoot%\windir directory for Windows operating system. 
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7.4.2 Performing Silent Installation 

To perform silent installation with a response file, use the command-line mode or a batch script to invoke AAE Installer 

and enable the response file that you created. 

On each system where you want to install AAE, invoke the installer using the following command syntax at the command-

line prompt: 

"D:\Setup_Files\Automation_Anywhere_Enterprise_Client_10.5.exe" /s "D:\Setup_Files\Setup.iss" 

NOTE: It is important to leave a space before specific commands as shown in the above example. 

To uninstall a Client, key-in the following at the command line prompt: 

"D:\Setup_Files\Automation_Anywhere_Enterprise_Client_10.5.exe" /s 

7.4.3 Special Notes 

• It is recommended that the setup.iss and the AAE Client setup exe should be in the same folder. Also, the 

setup.iss file should not be renamed. 

• Be sure to create separate response files for 32-bit and 64-bit operating system versions. 

• Silent installation can be used only for installing or uninstalling the product. It cannot be used for modifying or 

repairing the installation. 

• Use the /z option to pass data to the InstallScript system variable CMDLINE 

• Use opening and closing quotes (“”) in your source file path if it comprises a space. 

7.4.4 Viewing Log Files and Error Messages 

Two log files are generated during silent installation:  

 setup.log 

 productname.txt. 
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7.4.5 Working with the Setup.log File 

The Setup.log file is created in the same directory as the response file. 

The /f2 option enables you to specify an alternative log file location and file name. For example: “C:\Setup.exe” /s /f2 

"C:\Setup.log" 

Result codes with descriptions are listed in the table below: 

Result Codes Description 

0 Success 

-1 General Error 

-2 Invalid Mode 

-3 Required data not found in the setup.iss file 

-4 Not enough memory available 

-5 File doesn’t exist 

-6 Cannot write to response file 

-7 Unable to write to the log file 

-8 Invalid path to the Install shield Silent response (.iss) file 

-9 Not a valid list type (string or number) 

-10 Data type is invalid 

-11 Unknown error during setup 

-12 Dialog boxes are out of order 

-51 Cannot create the specified folder 

-52 Cannot access the specified file or folder 

-53 Invalid option selected 

 

7.4.6 Working with the Productname.txt file  

The Productname.txt file is created on the desktop when any of the following errors occur: 

 Required Microsoft.NET Framework is not present to install Microsoft .NET Framework 

 Services are not able to start. 

For further details on installation and uninstallation of the Control Room and Client, contact 

support@automationanywhere.com 
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8 AAE Client - Login to Control Room 
Automation Anywhere allows you to monitor and administer a large multi-site complex automation infrastructure using 

the web based Control Room. 

NOTE: 'Login' to Control Room is mandatory from Enterprise Edition 10.0 onward.  

 

8.1 Login to the Control Room 

1. As a Client user, launch Enterprise Client. 

2. Input Control Room URL in the Control Room field of the Login screen. 

Example: If your Control Room URL is http://productlt07:8080/controlroom, the Control Room URL for login will 

be http://productlt07:8080/controlroom 

3. Enter your Control Room user credentials. 

NOTE: The Control Room Admin can create a user in web-based Control Room. Refer User Management for 

details.  

4. If launching for first time, input the appropriate Control Room URL. On logging in the second time, your last 

login URL is displayed. If you wish to login using another URL, simply input the appropriate URL. Refer 

Connecting to Automation Anywhere Control Room for details. 
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8.2 Re-Login to Control Room 

1. To re-login Control Room using a different user credentials, click Tools→ Re-login. 

2. Input user credentials in the Login dialog that prompts. 

 
 

NOTE: The logged in username and status is displayed in the status bar. 

 

8.3 Unable to Login? 

If you cannot login to the Control Room, you can trouble-shoot based on the messages that you encounter. Possible 

reasons could be:  

 

• Invalid credentials - you might have input an incorrect username and/or password. 

• Non-Existent User - Client is not created in the Control Room to which you are trying to connect. 

• Unlicensed User - You have not been allocated the required license. 
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• Unverified - Email verification is pending. 

• Inactive User - The Control Room Admin has Deactivated your Client. 

• User is registered on another machine - When you try to login from a different machine (than the one from which 

you have registered). 

Also if, during login, the Client displays the following message, you will have to verify whether the Client and Control 

Room are configured to the same version: 

 
TIP: If the there is a major version mismatch i.e. if any of the component is of higher version than another, then you 

must upgrade to the appropriate version. 

 

To upgrade to the latest version, contact support@automationanywhere.com. 
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9 Additional Information 

9.1 Version Control System 

AAE supports Apache Subversion (SVN) as version control system. It is integrated to achieve some basic functionalities 

like Get Latest, Check-in, Check-out, Version history and Rollback, among others.  

SVN server might be hosted on cloud or within the network. Control Room connects via address and a port. Repository 

would be mapped to local drive of Control Room. Mapped directory will have latest copy of all the files always.  

 

As illustrated in above diagram, multiple Clients would request Control Room for different operations on files.  All the 

operations would be performed by a single SVN user account through Control Room. 

Control Room Admin can perform higher level functions like force unlock, base version upload and version history.   

To achieve all above, Control Room Admin has to configure SVN server address, port, and user account details prior to 

enabling the version control system.  
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9.2 Credential Vault  

9.2.1 Defining Credential Keys  

An Admin or IT Admin or any user having credential management permission can define Credential Keys that are 

required in the automation TaskBot(s) for task creation and task play. 

Credential Keys are defined and managed using the Credential Manager of the Control Room, which is basically a 

centralized location for creating and storing sensitive information that is included in automation TaskBot(s) in the 

form of Credential Variables.  

Refer the article on Assigning Credential Variables to understand more about Credential Variables. 

 

Defining Credentials involves building a repository of Credential Keys that includes Key Name, Description (optional), 

and its Attributes. 

Attributes that includes Attribute Name, Description and Value, hold key information regarding the credentials such 

as hostname, servername, username and password. 

9.2.2 Adding Credential and its Attributes 

You can add a Credential as mentioned: 

1. Click on the Add Credential' button given at the top of the Credentials list. 

 

2. Provide a unique key name in the Credential Name field that reflects the purpose of the Credential key and its 

description in the Description field. 

TIP: You can include Characters: A-Z, a-z, 0-9; Space (-), Hyphen (-) and Underscore (_). 
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3. Define the Key's Attributes - Name, Description, and Value.  

 
NOTE: Description is optional.  

TIP: Repeat the above process to add more attributes to the key. 

4. Click Save.  

 
NOTE: The Credential Vault stores the Credential Key in encrypted form.  

9.2.3 Editing Credential and its Attributes 

You can also edit a Credential Name and its Description as well as the Attribute Name, its Description and Values: 

NOTE: When you edit an Attribute name, the Control Room performs two operations; it first deletes the first instance 

of attribute and then creates a new attribute. 

1. To edit a Credential, select the Credential Key from the list and Click on  

2. Change the name, description, or value of the credential key. You can add or delete any of the attributes 

to/from the credential key. 

3. Save once it's modified. 
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9.2.4 Deleting Credential and its Attributes 

You can delete a Credential Name and its Description as well as the Attribute Name, its Description and Values.  

You can also opt to remove only Attributes or the Key itself.  

9.2.4.1 Deleting an Attribute 

1. To remove a Credential Attribute, click on  

2. Click   (available at the end of each Attribute label). 

 

3. Confirm the attribute deletion 

 

4. Click Save. 

9.2.4.2 Deleting a Credential 

To delete a Credential, select the Credential Key from the list.  

 Important: Remember, if you remove the Key, all Attributes are deleted. 

1. Click on  at the top. 
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2. Confirm the key deletion. 

`  

 Important: It is recommended, before deletion, confirm the key being deleted is not part of an 

automation task and proceed. Deleting a key that is used in automation TaskBot(s) will result in task play 

failure. 

9.2.5 Accessing Credentials in Client 

A Bot-Creator can access the Credentials stored in the Control Room while creating automation TaskBot(s). 

A Bot-Creator, while creating TaskBot(s), can assign the Credential variables in command fields that require credential 

input and support these. Refer the list of commands. 

NOTE: To access Credential variables during task creation and play, the Bot-Creator should be online i.e. connected to the 

Control Room.  

9.2.5.1 Using the Credential Variables 

The method to input Credential variables in commands that require them is similar to assigning variables. You simply 

press the function key 'F2'. The credential values are retrieved in the command during play time. 

Before you start assigning variables, remember: 

• A Bot-Creator can only insert the Credential variables in commands; no add or update rights are available to 

the Bot-Creator. 

• Credential Variables can be seen and accessed only from the Insert Variables window. 

• Only the name of a Credential Key is visible in the command field and list of Credential variables; Attribute 

values is not displayed. Not even while editing or debugging the task. 

• Bulk Edit is allowed only on commands that comprise same Credential variables. 

• A Credential variable is read only; hence you are not allowed to edit its values. Nor can you append another 

variable (Local or System variable) to it.  To insert such variables, you must delete the Credential variable first. 

• To delete a Credential variable, double click or hit 'Backspace' and then 'Delete'.  

• Copying and pasting of the variable converts it to string. Manually inputting the variable name also converts it 

to string. 
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9.2.5.2 Steps to Assign Credential Variables 

To assign variables in command fields that support Credential variables, follow the steps given below: 

 To add a Credential Variable, press F2 and select the required Credential 'Key' in the Insert Variable window: 

 

 Select the required Attribute 

 

 The command is assigned the credentials as shown: 

 

 Here, 'MyFTP' is the Credential Key, while 'HostName' and 'UserName' are its Attributes. 

NOTE: Password fields are displayed encrypted.  
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9.2.5.3 Commands that support Credential Variables 

The following commands support use of Credential variables: 

 Active Directory 

 Citrix Automation 

 Database 

 Email Automation 

 Excel 

 FTP/SFTP 

 Insert Keystrokes 

 Manage Windows Controls 

 Object Cloning 

 PDF Integration 

 PGP 

 REST Web Services 

 SAP Integration 

 SOAP Web Services 

 Terminal Emulator 

 Web Recorder 
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10 Upgrade Sequence 
Upgrade Steps for Automation Anywhere Enterprise. 

If you already have hands-ON experience in installing the AAE Client and Control Room, and the RPA Environment at your 

end already has an AAE Control Room and Clients, this section will guide you on the upgrade sequence. 

Consider an Automation Anywhere Enterprise deployment as mentioned in the image below.  

 

The deployment is a Load Balanced Environment having 

 Bot Creators 

 Bot Runners 

 A Load Balancer 

 Control Room Application Servers 

 Database Server 

 Control Room Web Socket Server 

 Control Room Repository Server 

To upgrade the above environment to the latest version of Automation Anywhere Enterprise Control Room and Client, 

please follow these Steps. 
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Step-1: Upgrade Steps for AAE Control Room 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Database 

Server 

A Take back-up of Control Room Database 

Configuration 

Backup 
B, C, Dx • Take a Backup of Enterprise settings and CredentialVault.dat file from 

Central Repository ..\Automation Anywhere Server Files\ 

• Take Backup of App Servers configuration files (Web\webcr.config, 

webcrserv\Web.config, scheduler\Web.config, hazelcast.xml) and 

Websocket server configuration file 

(Automation.CR.Web.SocketServer.exe.config),  

• Take backup of license file (AAECR.license) from Central Repository 

Application 

Servers 

Dx • Uninstall the old existing version of Control Room. 

• Verify Automation Anywhere Cache Manager service, 

AutomationAnywhereAppPool app pool and 

AutomationAnywhereScheduler app pool got removed 

Web Socket 

Server 

C 
• Uninstall the old existing version of Control Room.  

• Verify Automation Anywhere Web socket Server Service got removed 

Web Socket 

Server 

C 
• Install the latest version of Control Room. 

• Use same Certificate and password which was used in earlier version. 

• Ensure you have required access privileges to the folder that you choose 

as Repository.  

• Configure it to same Repository path which was used in earlier version. 

• Verify Web socket server connectivity with tool (e.g. – Mozilla Firefox 

Simple Web socket Client Addon) 

Application 

Servers 

Dx 
For each of the Application Servers 

• Install the new version of AAE Control Room 

• Use same Certificate on IIS which was used in earlier AAE version. 

• Make sure that the DB user has the ‘DB owner’ privilege. 

• Configure new AAE to same Database which was used for earlier AAE 

• Configure new AAE to same Repository path which was used earlier. 

• Verify AutomationAnywhereAppPool app pool, 

AutomationAnywhereScheduler app pool, AutomationAnyweherAPI 

app pool and Automation Anywhere Cache Manager service got 

created 

• Replace license backup file to (webcrsvc\bin\ and shared Central 

Repository) 

• Login with non-admin user who has license management privileges to 

verify license status (ensure that you do not use a browser wherein 

you had previously logged in with admin privilege.) 
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10.1 Post Installation Check-list for Control Room 

10.1.1 Standalone Mode  

1. Login to Control Room using Admin. This will open the Credential Vault. 

2. To confirm whether the Credential Vault is open, go to Audit Trail wherein an audit entry for credential vault is 

logged - Credential Vault connected successfully. 

3. Login to all required AAE Clients one by one and login to Control Room & verify the same. The Clients that are 

online are shown in Green colour in the Clients tab. 

4. Compare & validate Control Room Dashboard against, screenshot taken during pre-upgrade checklist like, 

Registered clients, Active users, No. of folders and files in Control Room repository, etc… both should be identical 

after upgrade. 

5. Press ‘F12 – developer tools” and Click on Operations room, in console to verify whether the connection is 

opened & Auth request has succeed for ‘Web socket connection’. If connection fails then verify web socket 

service is up and running and Web socket host name and port is correct in Web.config file at location (e.g: 

C:\Program Files (x86)\Automation Anywhere Enterprise 10.5\Control Room\Web\webcrsvc) 

6. Verify after 10-15 mins that none of the AAE Clients are disconnected or display session expired message. 

 Verify following scenarios:  

• Upload a sample TaskBot and its dependency 

Steps: 

1. Login to AAE Client that has been assigned a Bot creator (Development) license. 

2. From AAE client select sample Taskbot with dependency in different folder. 

3. Upload the same from AAE Client to Control Room. 

Expected: 

1. Should get upload successful message in AAE Client. 

2. Login to Control Room and verify in Repository manager that uploaded task bot along with its dependencies 

are present in respective folders. 

3. Verify the in Audit trail for “Task ‘<taskname.atmx>’ uploaded successfully” message. 

• Download a sample TaskBot and its dependency 

Steps: 

1. Login to AAE Client that has been assigned a Bot creator (Development) license. 

2. In AAE Client go to Repository. 

3. Select sample TaskBot with dependency in different folder from Server. 

4. Download the same from Server to AAE Client. 

Expected: 

1. Should get Download successful message in AAE Client. 

2. Verify in AAE Client Repository that downloaded TaskBot along with its dependencies are present in 

respective folders. 

3. Login to AAE Control Room and verify the in Audit trail for “Task <taskname.atmx> downloaded successfully” 

message 

https://support.automationanywhere.com/


 

Copyright © 2018 Automation Anywhere, Inc.  P a g e  139 https://support.automationanywhere.com 

 

 

• Verify local schedule with auto-login on AAE Client in Lock mode 

 Steps: 
1. Login to AAE client having Bot runner (Runtime) license 
2. Set the auto login credentials in Tools->Options on AAE Client & select “Autologin your computer…” checkbox 
3. Create a local schedule on AAE client using sample task 
4. Lock the AAE client machine 
5. Wait till the schedule gets fire  

 
 Expected: 

1. Schedule should fire on local client 
2. Auto login should work successfully, and player should invoke to run the task 
3. There won’t be any audit log for this in Control Room 
 
Note: “Local schedule with auto-login on AAE Client in Lock mode” scenario can be tested using different type of 
schedules on bot runner.

 

• Deploy and run from Control Room to AAE Client 

     Steps: 
1. Login to AAE client having Bot runner (Runtime) license 
2. Set the auto login credentials in Tools->Options on AAE Client & select “Autologin your computer…” checkbox 
3. Lock the AAE client machine 
4. Login to Control Room with admin user, select sample task and choose ‘Run’ option 
5. Select above bot runner to run the task and click on Run button 

  
 Expected: 

1. Should see “Task ‘<taskname.atmx>’ deployed successfully on selected client(s).” message in Control Room 
2. The same message should be logged & available in Control Room Audit log 
3. Bot runner machine should be unlocked using auto login credential, player should be invoked, and task should 

run 
4. Should see task in progress in Control Room Operation room -> Task in progress tab 
5. After task completed successfully, player should be closed on AAE Client machine and machine should go 

again in locked mode 
6. Now there should not be task in progress entry in Control Room Operation room -> Task in progress tab 
7. The history of task available in Control Room Operation room -> Task history tab 
8. Should see Task run completion entry in Control Room audit log as “Task ‘<taskname.atmx>’ completed. Run 

duration xx:xx:xx” 
 

• Schedule and run from Control Room with auto-login on AAE Client 

Steps: 
1. Login to AAE client having Bot runner (Runtime) license. 
2. Set the auto login credentials in Tools->Options on AAE Client & select “Autologin your computer…” 

checkbox. 
3. Lock the AAE Client machine. 
4. Login to Control Room with admin user, select sample task and choose ‘Schedule’ option. 
5. Select the desired options for, 

Schedule name: TestSchedule 
Recurrence: None/Daily/Weekly/Monthly  
Start date: Today’s date 
Schedule Time: 10 mins from current time. 
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6. Select above bot runner to schedule the task and click on Save button. 
7. Let the schedule fire on bot runner from Control Room. 
 

 Expected: 
1. Should see “Schedule ‘<Schedule name>’ created successfully” description in Control Room audit log. 
2. Same schedule should be available in “Task schedule” tab of Control Room with correct Start date/time and 

Next occurrence date/time. 
3. Once the schedule get fired on bot runner, should see “Task '<taskname.atmx>' of schedule '<Schedule 

name>' deployed successfully on: <Host name>” description in Control Room audit log. 
4. Bot runner machine should be unlocked using auto login credential, player should be invoked, and task should 

run. 
5. Should see task in progress in Control Room Operation room -> Task in progress tab. 
6. After task completed successfully, player should be closed on AAE Client machine and machine should go 

again in locked mode. 
7. Now there should not be task in progress entry in Control Room Operation room -> Task in progress tab. 
8. h. The history of task available in Control Room Operation room -> Task history tab. 
9. Should see Task run completion entry in Control Room audit log as “Task ‘<taskname.atmx>’ completed. Run 

duration xx:xx:xx”. 
10. If schedule has next occurrence available, then it will be still visible in Control Room -> Task schedule tab or 

else entry will not be visible in Task schedule tab. 
 

Note: Schedule and run from Control Room with auto-login on AAE Client” scenario can be tested using different 

type of schedules from Control Room. 

10.1.2 Distributed Mode (High-Availability Control Room) 

Verify below steps using individual Control Room Server URL and finally using Load balancer URL: 
 

1. Login to Control Room using Control Room Admin user so that Credential vault will be opened, only for first time 

CR Admin login. 

2. Go to Audit Trail and confirm Credential vault is open, there should be audit entry saying, “Credential Vault 

connected successfully.” only after first time CR Admin login. 

3. Login to Control Room using Control Room Admin user to Compare & validate Control Room Dashboard against, 

screenshot taken during pre-upgrade checklist like, Registered clients, Active users, No. of folders and files in 

Control Room repository etc… both should be identical after upgrade. 

4. Login to all required AAE clients one by one and login to Control Room & verify the same are online (Green 
colour) in Clients tab. 

 
5. Press ‘F12 – developer tools” and Click on Operation room, in console verify Connection opened & Auth request 

succeed. For ‘Web socket connection’ – If connection failed then verify web socket service is up and running in 
Data and service layer and in Control Room settings Web socket host and port are correct. 
 

6. Verify after 10-15 mins none of the AAE Clients should not get disconnected or get Session expired message.  
 
Verify following scenarios:  
 

• Upload a sample TaskBot and its dependency 

Steps: 
1. Login to AAE client having Bot creator (Development) license. 
2. From AAE client select sample TaskBot with dependency in different folder. 
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3. Upload the same from AAE Client to Control Room. 
 
Expected: 
1. Should get upload successful message in AAE Client. 
2. Login to Control Room and verify in Repository manager that uploaded task bot along with its dependencies 

are present in respective folders. 
3. Verify the in Audit trail for “Task ‘<taskname.atmx>’ uploaded successfully” message. 

 

• Download a sample TaskBot and its dependency 

Steps: 
1. Login to AAE Client having Bot creator (Development) license. 
2. In AAE client go to Repository. 
3. Select sample TaskBot with dependency in different folder from Server. 
4. Download the same from Server to AAE Client. 
 
Expected: 
1. Should get Download successful message in AAE Client. 
2. Verify in AAE client Repository that downloaded task bot along with its dependencies are present in 

respective folders. 
3. Login to AAE Control Room and verify the in Audit trail for “Task <taskname.atmx> downloaded successfully” 

message. 
 

• Verify local schedule with auto-login on AAE Client in Lock mode 

 Steps: 
1. Login to AAE client having Bot runner (Runtime) license. 
2. Set the auto login credentials in Tools → Options on AAE Client & select “Autologin your computer…” 

checkbox. 
3. Create a local schedule on AAE client using sample task. 
4. Lock the AAE client machine. 
5. Wait until the schedule is fired. 

 
 Expected: 

1. Schedule should fire on local Client. 
2. Auto login should work successfully, and player should invoke to run the task. 
3. There won’t be any audit log for this in Control Room. 
 
Note: “Local schedule with auto-login on AAE Client in Lock mode” scenario can be tested using different type of 
schedules on Bot Runner. 

 

• Deploy and run from Control Room to AAE Client 

     Steps: 
1. Login to AAE client having Bot runner (Runtime) license. 
2. Set the auto login credentials in Tools->Options on AAE Client & select “Autologin your computer…” checkbox 
3. Lock the AAE client machine. 
4. Login to Control Room with admin user, select sample task and choose ‘Run’ option. 
5. Select above bot runner to run the task and click on Run button. 

  
 Expected: 

1. Should see “Task <taskname.atmx> deployed successfully on selected Client(s).” message in Control Room. 
2. The same message should be logged & available in Control Room Audit log. 
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3. Bot runner machine should be unlocked using auto login credential, player should be invoked, and task should 
run. 

4. Should see task in progress in Control Room Operation room → Task in progress tab 
5. After task completed successfully, player should be closed on AAE Client machine and machine should go 

again in locked mode. 
6. Now there should not be task in progress entry in Control Room Operation room → Task in progress tab. 
7. The task history is available in Control Room Operation room → Task history tab. 
8. Should see Task run completion entry in Control Room audit log as “Task ‘<taskname.atmx>’ completed. Run 

duration xx:xx:xx”. 
 

• Schedule and run from Control Room with auto-login on AAE Client 

Steps: 
1. Login to AAE client having Bot runner (Runtime) license. 
2. Set the auto login credentials in Tools->Options on AAE Client & select “Autologin your computer…” 

checkbox. 
3. Lock the AAE Client machine. 
4. Login to Control Room with admin user, select sample task and choose ‘Schedule’ option. 
5. Select the desired options for: 

Schedule name: TestSchedule 
Recurrence: None/Daily/Weekly/Monthly  
Start date: Today’s date 
Schedule Time: 10 mins from current time 

6. Select above bot runner to schedule the task and click on Save button. 
7. Let the schedule fire on bot runner from Control Room. 

  
 Expected: 

1. Should see “Schedule <Schedule name> created successfully” description in Control Room audit log 
2. Same schedule should be available in “Task schedule” tab of Control Room with correct Start date/time and 

Next occurrence date/time 
3. Once the schedule get fired on bot runner, should see “Task '<taskname.atmx>' of schedule '<Schedule 

name>' deployed successfully on: <Host name>” description in Control Room audit log 
4. Bot runner machine should be unlocked using auto login credential, player should be invoked, and task should 

run 
5. Should see task in progress in Control Room Operation room -> Task in progress tab 
6. After task completed successfully, player should be closed on AAE Client machine and machine should go 

again in locked mode 
7. Now there should not be task in progress entry in Control Room Operation room -> Task in progress tab 
8. The history of task available in Control Room Operation room -> Task history tab 
9. Should see Task run completion entry in Control Room audit log as “Task ‘<taskname.atmx>’ completed. Run 

duration xx:xx:xx” 
10. If schedule has next occurrence available, then it will be still visible in Control Room -> Task schedule tab or 

else entry will not be visible in Task schedule tab. 
 

Note: “Schedule and run from Control Room with auto-login on AAE Client” scenario can be tested using different 

type of schedules from Control Room. 
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Step-2: Upgrade Steps for Bot Creators and Bot Runners 

 

 

 

 

 

 

 

10.2 Post Installation Check-list for AAE Client 

1) Ensure that all Bot Creators and Runners can indeed login to the Control Room and can upload, download bots 

2) Verify that you can indeed Run the bot on a connected Bot Runner. 

3) Make a test schedule and ensure that it gets triggered as expected on the Bot Runner(s) 

4) Ensure that the existing schedules are triggered as expected. 

Bot Creators  Fx For each of the Bot Creators 

• Install the new version of AAE Client. 

• Invoke AAE Client and check if login to Control Room works fine. 

Bot Creators  Gx For each of the Bot Runners 

• Install the new version of AAE Client. 

• Invoke AAE Client and check if login to Control Room works fine. 
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